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1. fejezet

Mi a szimuláció?
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Mi a szimuláció?

A szimuláció egy rendszer leképezése dinamikus folyamataival együtt egy

olyan modellben, amellyel kísérletezni lehet. Célja olyan eredmények

szerzése, amelyek a valóságban felhasználhatók.

VDI 3633, Blatt 1, 1993
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Szimuláció használata

Új létesítmény tervezése:

Az idők és teljesítmény

meghatározása és optimalizálása.

Méretezés meghatározása.

Teljesítménykorlátok meghatározása.

A hibák bekövetkezésének elemzése.

Emberi erőforrásigények felmérése.

A létesítmény működéséről információ

gyűjtése.

Lehetséges vezérlési stratégiák

meghatározása

Különböző alternatívák kipróbálása.

Meglévő létesítmény optimalizálása:

Vezérlési stratégiák optimalizálása.

Műveleti sorrend optimalizálása.

Napi teljesítmény tesztelése.
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Mit várunk a szimulációtól?

• Tárolóméretek

• Szállítóeszközök, 

AGV-k száma

• Munkadarab hordozók 

száma

• A létesítmény 

kihasználtsága

• A gépek 

kihasználtsága

• A teljesítmény 

• Gyártási idő

• Emberi erőforrás

• Tároló hely méret

növekszik csökken

megha-

tározható

• Tervezési alternatívák

• Vezérlési stratégiák

• Tervezési hibák 

• Beruházások

- kipróbálása

- optimalizálása

- elkerülése

- megőrzése

A létesítmény profitjának növelése!
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Elkerülendők

• Nem pontos leírások és paraméterek a szimulációs modellben.

• A cél hibás vagy hiányzó volta.

• Túl részletes és túl kiterjedt modellezés.

• Túl egyszerűsített modellezés, ami használhatatlan eredményeket ad. 

• Nem eléggé ellenőrzött modellje a létesítménynek.
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3 szakasz*

- Előkészítés

- Végrehajtás

- Elemzés

• Döntés: megéri szimulációt készíteni?

• A feladat és a cél definiálása

• Erőfeszítés megbecsülése

• Adatok gyűjtése, előkészítése, ellenőrzése

• Analitikus durva becslés

• Szimulációs modell készítése, ellenőrzése

* forrás: VDI 3633 és ASIM útmutató, 1997

Szimulációs feladat szakaszai
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- Előkészítés

- Végrehajtás

- Elemzés

• Plant Simulation kísérletek

• Szimulációs kísérletek végrehajtása

• Szimulációs kísérletek ellenőrzése

Szimulációs feladat szakaszai
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- Előkészítés

- Végrehajtás

- Elemzés

• Eredmények formázása

• Eredmények értelmezése

• Eredmények dokumentálása

Szimulációs feladat szakaszai

10



www.graphit.hu

Szimulációs projekt végrehajtása

 Probléma és cél definiálása

 Rendszer analízis

 Adatgyűjtés

 Modell készítése

 Modell ellenőrzése

 Kísérletezés és modell analízis

 Eredmények értelmezése

 Javaslatok készítése
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Szimulációs projekt végrehajtása

 Probléma és cél definiálása

• Probléma lebontása

• Érdemes a problémát szimulálni?

• Szimuláció céljainak definiálása

Például:

Gyár kapacitásának megbecslése

Tárolók, pufferek méretezése

Megfelelő vezérlési stratégiák készítése

Optimális számú személyzet kialakítása
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Szimulációs projekt végrehajtása

 Probléma és cél definiálása

 Rendszer analízis

 Adatgyűjtés

 Modell készítése

 Modell ellenőrzése

 Kísérletezés és modell analízis

 Eredmények értelmezése

• A szimulálni kívánt rendszer leírása

• A rendszer struktúrájának definiálása

• A szimuláció környezetének definiálása (a környezet határai)

Cél rendszer

Nyersdarabok tárolása KiszállításGyártás

Kész alkatrészek tárolása
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Szimulációs projekt végrehajtása

• Lebontás különálló rendszerelemekre

• Rendszerelemek adatainak gyűjtése, jellemzők 

definiálása

Gép

 Probléma és cél definiálása

 Rendszer analízis

 Adatgyűjtés
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Szimulációs projekt végrehajtása

 Modell készítése

 Modell ellenőrzése

• A valós rendszer modellé alakítása a kísérletezéshez

• Annak ellenőrzése, hogy a modell és a valóság 

megfelelően megegyezik
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Szimulációs projekt végrehajtása

 Kísérletezés és modell analízis

 Eredmények értelmezése

 Javaslatok készítése
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Szimulációs projekt végrehajtása

 Probléma és cél definiálása

 Rendszer analízis

 Adatgyűjtés

 Modell készítése

 Modell ellenőrzése

 Kísérletezés és modell analízis

 Eredmények értelmezése

 Javaslatok készítése
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Feladatok megoszlása: szimulációs projektekre* (egyszeri projektekre, forrás IWB 1997)

Erőfeszítések megoszlása
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 Ne általánosítson szimulációs eredmények alapján

 Tervezze meg pontosan a kísérleteket

 Ellenőrizze a modellt

 Dokumentálja a bemeneti adatokat és kapcsolatokat

pontosan

 Készítsen annyira részletes modellt, amennyire

szükséges, ami annyira általánosított, amennyire

lehetséges

 A szimulációt végezze valós adatokkal

Kísérletek megtervezése
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Hogyan készül szimulációs projekt?

Absztrakció

Modellépítés

Értelmezés

Gyakorlati használat

Kísérletezés

Módosítások Eredmények

Mely részeket kell 
modellezni? 

A szimuláció célja? 

Szimuláció futtatás

Mely paramétereket
kell változtatni? 

Hogyan lehet használni  
az eredményeket a 

gyakorlatban?

Milyen következtetések 
vonhatók le?

Dokumentálás
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Plant Simulation: diszkrét esemény-
orientált szimuláció

A diszkrét esemény-orientált szimuláció bizonyos időpillanatokban

mutatja a modell komponensek állapotváltozását, nem folytonosan az

időben. Amikor bizonyos esemény megtörténik, a megfelelő modell

komponensek állapota megváltozik. A Plant Simulation ezeket az

eseményeket lépésről lépésre dolgozza fel. A fő előnye ennek a

megközelítésnek, hogy a Plant Simulation nem foglalkozik az

események közötti idővel.

Emellett a Plant Simulation objektum orientált alkalmazás, ami azt

jelenti, hogy gyermek objektumok képesek tulajdonságokat és

jellemzőket örökölni a szülő objektumuktól.
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2. fejezet

Plant Simulation Licenctípusok
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Licenctípusok és opcionális termékek

Licenctípusok: Opcionális termékek:

● Plant Simulation Professional

● Plant Simulation Standard

● Plant Simulation Application

● Plant Simulation Runtime

● Plant Simulation 3D

● Plant Simulation Interface 

Package

● Plant Simulation Gantt

● Plant Simulation Aris

● Plant Simulation SDX

● Process Designer Interface

● Plant Simulation Assembly

● Plant Simulation Shop

● Plant Simulation Research*

● Plant Simulation Educational**

Oktatási csomagok:

* Kutatási célra

** Oktatási célra
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3. fejezet

A Plant Simulation modellfájl
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A Plant Simulation elindítása

A Plant Simulation a Tecnomatix szabványos platformján a TUNE

alrendszeren fut.

MS Windows 2000 és MS Windows XP operációs rendszerek alatt

A Plant Simulation indításakor a megfelelő felhasználói licenc ikonját kell

elindítani, pl:

Start > Programs > Tecnomatix > Plant Simulation x.y > Plant Simulation

(licenctípus neve)
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A Plant Simulation programablaka

A Plant Simulation programablaka menüket,

eszköztárakat és Viewer (néző) ablakokat

tartalmaz:

- az üres Toolbox

- az Explorer és

- a Console.

Megjelenítésük a

View > Viewers > megjeleníteni kívánt elem

menüpont alatt kapcsolható be.

Az Info Pages (információs lap)

hivatkozásokat tartalmaz a Plant Simulation

weboldalaira és számos kapcsolódó témára.
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Az alapértelmezett modellfájl

Erre a gombra kattintva, vagy a menü

File > New Model

parancsát kiválasztva új modellfájl

nyílik meg. Ez a fájl tartalmazza a

Class Library - t (osztálykönyvtárt) a

beépített Plant Simulation

objektumokkal.

Kattintson erre a gombra meglévő

modellfájl megnyitásához, vagy

válassza ki a következő

menüparancsot

File > Open Model

A legutóbb használt fájlok listája a legutóbb használt nyolc darab modellt mutatja.

27



www.graphit.hu

A modellfájl osztálykönyvtára

A modellfájl tartalmazza a Class Library - t

a beépített objektumokkal hierarchikus

faszerkezetben.

A különböző mappák különböző objektum

osztályokat tartalmaznak.

A struktúra módosítható és bővíthető a

szimulációs projekt igényeinek

megfelelően.

Például készíthetők új mappák a

szimulációs modellek tárolására,

tesztelésre.

* MU: mozgó objektumok, amelyek az egyik anyagáramlási objektumtól a másikig

mozognak a szimulációs modellben

*
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Elem hozzáadása a struktúrához

Új mappa (Folder) vagy Frame

vagy eszköztár hozzáadása a

tárolásukra használt mappa helyi

menüjéből a New menüpontot és a

hozzáadni kívánt objektum típusát

kiválasztva lehetséges.
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Struktúra módosítása

Egy mappa vagy objektum átmozgatása ugyanabban a

struktúrában (azonos szinten) egyszerűen húzd és ejtsd

módszerrel történik.

Egy mappa vagy objektum átmozgatása más struktúrába

(más szintre) az elem kiválasztásával, majd a húzd és

ejtsd művelet közben a Shift billentyűt nyomva tartva

lehetséges.

Fontos tudni, hogy a struktúra módosítása a mappanevek megváltoztatása

egy meglévő szimulációban azt okozhatja, hogy a szimuláció a továbbiakban

nem fog működni.
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Objektum átnevezése

Objektum átnevezése:

• Kétszer kattintva rajta,

• Az F2 billentyű lenyomásával,

• A helyi menüből a Rename parancs

kiválasztásával lehetséges.

Egy megnyitott objektum az F2 billentyű lenyomásával nevezhető át a Rename

párbeszédablakban.
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Objektumok felhasználói nevei

• Betűvel kell kezdődni, amit betűk vagy számok követhetnek. Aláhúzás (_)

használható. Ne használjon speciális karaktereket!

• Nem érzékenyek a kis- és nagybetűkre, ezért használhatók a kis- és nagybetűk

tetszőlegesen.

• Nem tartalmazhatnak kulcsszavakat, mint például if, then, else, from, until,

loop, result, ...

• Egy névterületen belül csak egyszer fordulhatnak elő.

Példák:

Helyes: Station_1, Station1, millingMaschine, conveyor

Helytelen: Station 1, IF, 35-conveyor, 275Station
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Modellfájl mentése

Mentés történhet az eszköztár szabványos mentés

gombjára kattintással, vagy a következő menüpont

kiválasztásával:

File > Save Model vagy File > Save Model As

A modell első mentésekor a Plant Simulation

létrehozza a fájlt .spp kiterjesztéssel.

Ezek után a Plant Simulation a modell változásait

ebbe a modellfájlba (*.spp) menti.

Ezzel egy időben a Plant Simulation átnevezi az

előzőleg mentett verzióját a modellfájlnak .spp.bak

kiterjesztésű, azonos nevű fájllá.

Ez a biztonsági mentésfájl a modell utoljára mentett változatát tartalmazza. A Plant

Simulation - ben szükség esetén a .bak fájl közvetlenül megnyitható.
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Biztonsági mentésfájl megnyitása

A lenyitható listából kiválasztható a megnyitni kívánt modell típusa Files of type:

.spp (modellfájl) vagy .bak (biztonsági mentésfájl).

Ha a modell 3D modell, akkor előnézet (preview) is látható róla.
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A fő eszköztár

Manage Class 

Library/Osztálykön

yvtár kezelése

Class Library/

Show Explorer

Navigátor mutatása

Show Console

Konzol 

mutatása

Show Toolbox/

Eszköztár mutatása Index Help 

(F1) - Súgó

Open active EventController

Eseményvezérlő 

megnyitása

MU Animation

MU animáció

Icon Animation

Ikon animáció

Show 3D Library/3D 

navigátor mutatása

Hide/Show Dialogs

Párbeszédablakok 

mutatása/elrejtése
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Anyagáramlás (material flow) objektumok 
és mozgó objektumok (MU)

• Ezekkel lehet modellezni az

anyagáramot a modellben.

• Az objektumok között

megtalálhatók az egyszerű

feldolgozó elemektől a

bonyolult szerelő elemekig

számos objektum
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Erőforrás (resource) objektumok

Dolgozók és más osztott erőforrások (pl. 

szerszámok) modellezésére szolgálnak
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Információ áramlás 
(information flow) objektumok

Kontroll stratégiák készítésére, információ kezelésére és 

eredmények feldolgozására használhatók
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Felhasználói felület
(user interface) objektumok

Eredmények gyűjtésére szolgálnak, és 

felhasználói felület készítésére
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Eszközök (tools) objektumok

Információ gyűjtő objektumok (Sankey, 

Bottleneck Analyzer) és speciális objektumok

(PortalCrane és TransferStation)
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Keretek (Frames)

A szimulációs modellek keretekben (Frame) készíthetők el anyagáram objektumok

beillesztésével és összekapcsolásával. A szimuláció is a kereten belül futtatható le.

Tetszőleges számú új Frame készíthető a hierarchia bármely szintjén a Class Library

- ban. A hierarchia elemének helyi menüjében a New > Frame menüpontot

kiválasztva készíthető el az új keret.
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Plant Simulation kiegészítések

A Class Library kibővíthető további Plant

Simulation alkalmazásokkal.

Általában ezek opcionális modulok,

amelyekhez külön licenc szükséges, és

bizonyos speciálisabb modell optimalizációs

feladatokra nyújtanak megoldást.

A Class Library kezelése, bővítése a File >

Manage Class Library… menüparanccsal

lehetséges.
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Plant Simulation kiegészítések

ODBC

Kétirányú adatcsere interfész Windows

ODBC alapú adatforrásokhoz.

Oracle

Tetszőleges Oracle adatbázishoz

kapcsolódás interfésze.

Socket

Szabványos TCP/IP protokoll alapú

alkalmazásokhoz kapcsolódás

interfésze.

ActiveX

ActiveX vezérlőkhöz szükséges interfész,

amivel ilyen vezérlőkkel lehet adatot

cserélni.

Aris

Aris - IDS, Prof. Scheer üzleti folyamatok

modellezésére szolgáló objektumokhoz

szükséges interfész.

GA

Modell automatikus optimalizálására

szolgáló genetikus algoritmus.

Gantt

Termelési tervek grafikus megjelenítése és

interaktív módosítása.
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Beállítások – Mértékegységek
Options–Units

A Plant Simulation a megadott értékeket

automatikusan konvertálja a Tools >

Options > Units menüpont alatt megadott

Mass (tömeg), Speed (sebesség) és

Length (hossz) mértékegységekre, ha

más mértékegységet választ.

A Length (hossz) esetében megadható 

olyan Length Unit (hossz egység), 

amely megfelel az igényeknek, mint pl:

1LU = 0.341 miles.

A Plant Simulation nem konvertálja a

Currency (pénznem) értékét.

A Time scale (idő mérték) megadható az igényeknek megfelelően a megfelelő

értéket beírva a szövegmezőbe.

A Plant Simulation beállítások a Tools > Preferences vagy Tools > Model

Settings menüpontok alatt adható meg. A Preferences beállításai új modellekre

vonatkoznak, míg a Model Settings beállítások az aktuális modellre.
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4. fejezet

A Plant Simulation 

felhasználói felülete
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A felhasználói felület

A Plant Simulation egy több

dokumentumos alkalmazás, amely

szabványos Windows felhasználói

felületet nyújt.

Különböző jellegű ablakok vannak. A

párbeszédablakok általában más

ablakok előtt jelennek meg.

A menü és az eszköztárak, akárcsak a

megjelenítő ablakok mérete,

testreszabható.
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Különböző ablaktípusok

Viewer (megjelenítő) ablakok:

• Explorer (Tab Viewer)

• Console

• Objects Palette (Toolbox)

Objektum ablakok

• Frame

• Method

• TableFile, StackFile, ...

Párbeszéd ablakok

• Az objektumokhoz

A TUNE rendszer három típusú ablakot jelenít meg:
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Ablakok dokkolása és mozgatása

A megjelenítő ablakok, a menük

és az eszköztárak dokkolhatók,

vagy a dokkolásból kivehetők és

mozgathatók.

Ha egy megjelenítő ablakot

mozgat, és nem akarja, hogy az

ablak széléhez dokkoljon, tartsa

lenyomva a Ctrl billentyűt.
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Megjelenítő ablakok mutatása és elrejtése

A megjelenítő ablakok bezárhatók és megjeleníthetők megint az eszköztáron az

ikonjukra kattintva. Újra megjeleníthetők a View > Viewers menüparancs alatt a

megfelelő ablak nevének kiválasztásával.
Console

Konzol

Class Library

Osztálykönyvtár

Toolbox

Eszköztár

3D Library

3D könyvtár
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Ablakok elrendezése

Az objektumok ablakai a fő ablakon belül

helyezkednek el, nem lehet azon kívül

mozgatni.

A megnyitott megjelenítő ablakok az

objektumablakok előtt jelennek meg.

A megnyitott párbeszédablakok a

megjelenítő ablakok és az

objektumablakok előtt jelennek meg.

Ezekben értékeket lehet megadni

szövegmezőkben, vagy értékeket lehet

kiválasztani listadobozokban.

A megnyitott objektumablakok a következő menüpontokkal rendezhetők el: 

Window > Cascade (lépcsőzetes), Tile Horizontally (vízszintes mozaik), 

Tile Vertically (függőleges mozaik).
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Menük és eszköztárak testreszabása

Plant Simulation menük és

eszköztárak testreszabása:

A menü vagy eszköztár helyi

menüjéből a Customize

(testreszabás) menüpontot

kiválasztva. Ekkor megjelenik a

Customize párbeszédablak.

Megjelennek a parancsok és

kategóriáik, és a hozzájuk

kapcsolódó menüparancsok és

ikonok.

Válassza ki a parancsot a listában,

és húzza a kívánt helyre a menüben

vagy az eszköztáron, és ejtse oda.
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1 .lecke: Munka a Plant Simulation 
ablakokkal

• Próbálja ki a megjelenítő ablakok mozgatását, dokkolását, dokkolásból kivételét.
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5. fejezet

Létesítmény szimulációja
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Gyár elrendezés

CutToSize

Méretrevágás

Milling1

Marás 1

Paintshop

Festőüzem

Quality

control

Minőség-

ellenőrzés

Packing

Csomagolás

Receiving

Table-Legs

Asztallábak érkezése

Milling2

Marás 2

Shipping

Szállítás

Buffer

Tároló

Assembly

Szerelés
Conveyor - Szállítószalag

Rejects

Selejt

Store

Table-Tops

Asztallapok tárolása
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Gyár szimulációja

A tesztgyár asztalokat készít:

• Először egy fűrészállomáson az asztallapokat méretre vágják.

• Aztán két marógép megmunkálja az asztallapok éleit.

• Ezután festőrobotok az asztallapokat különböző színűre festik. A

minőségellenőrzés a hibásan festett lapokat visszaküldi a selejt

állomásra, ahol a festést kijavítják.

• A szerelőállomáson az asztallapokhoz hozzáadják az asztallábakat.

• Az elkészült asztalok a csomagolásra mennek, ami után készek a

szállításra.

• A becsomagolt asztalok az ügyfélhez történő szállításra várnak.
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A gyár szimulációja

Először elkészül a gyártóüzem egy durva szimulációs modellje. Ebből a

célból a gyártást kisebb egységekre kell felbontani, amelyek megfelelnek

egy-egy feldolgozási cellájának a gyártásnak.

Mindegyik egységet külön modellezzük, és az adott feldolgozó cella

viselkedését a szükséges részletességgel dolgozzuk ki.

Így megismerjük a

legfontosabb Plant

Simulation objektumokat,

és a működésüket. Emellett

a szimulációs modell

elkészítésének

gyakorlására is mód nyílik.
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Modellezési megközelítések

Föntről-lefelé stratégia:

Egy durván strukturált modellel jellemzett, ami fokozatosan lépésről lépésre

kerül lebontásra. Ahogy finomodik a modell úgy lesz egyre részletesebb is. Ez

a megközelítés jelentős absztrakciót igényel.

Lentről-fölfelé stratégia:

Egy részletes modellel jellemzett, előre gyártott struktúrákból, jelentősen

alacsonyabb absztrakciós szinten. Lehetővé teszi a részletek gyors elemzését,

viszont megnehezíti a nagy egész áttekintését.

A tanfolyam során mindkét módszert használni fogjuk.
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Emlékeztető: A Class Library szerkezete

Hogy áttekinthetőek legyenek a

komponensek, először elkészítjük a Class

Library -ben a projekt struktúráját:

Új mappa készítéséhez válassza ki Class

Library -ben a létrehozás helyén lévő

mappa helyi menüjéből a

New > Folder parancsot.

Egy meglévő mappa átnevezéséhez válassza ki a mappa helyi menüjéből a

Rename parancsot, vagy nyomja le az F2 billentyűt.
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A projekt elkezdése

Plant Simulation indítása

Zárjon be minden megnyitott modellfájlt.

Nyissa meg ezt a modellfájt:

Mappa: [az oktató által megadott útvonal]

Fájl: StartingModel_M1_V76

Mentse el a modellt tetszőleges saját

néven!
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2. lecke

A Class Library 

(osztálykönyvtár) szerkezete

Készítse el az ábrán látható

mappaszerkezetet a Class Library-ban

az osztálykönyvtár legfelső szintjén:

• Exercises

• FacilityComponents

• TestModel
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6. fejezet

A szimulációs modell elkészítése
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A szimulációs modell durva szerkezete

A fentről-lefelé stratégiával elkészítjük a létesítmény durva modelljét egy

Frame-ben. A gyár minden egyes cellájának modellezésére egy SingleProc

objektumot használunk.

Először megismerjük a lépéseit a modell létrehozásának, és utána ezeket a

lépéseket a gyakorlatban is alkalmazzuk.
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• Ikon:

• Kapacitás: bármennyi

• Aktív anyagáramlás objektum

Source – Forrás - létrehozás

Jellemzők:

A Source hozza létre az MU-kat (mozgó

egységek), a megadott paraméterek

alapján:

Time of creation (létrehozás ideje)

Interval Adjustable (intervallum),

Number Adjustable (szám) vagy

megadott Delivery Table (kibocsátási

táblázat) alapján.
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Source – MU kiválasztás

A Source hozza létre az MU elemeket az MU selection lenyíló lista beállítása 

alapján:

Constant (konstans): Amikor az

MU típusa mindig ugyanaz

(alapértelmezés).

Sequence Cyclical (ismétlődő

sorrendben): A táblázatban

megadott sorrendnek megfelelő az

MU típus. A tábla további

információt is tartalmazhat, a Plant

Simulation a táblát ismétlődően

dolgozza fel.

Sequence (sorrendben): a Plant

Simulation a megadott nevű

táblázatot egyszer dolgozza fel.

Random (véletlenszerűen): a Plant Simulation a táblában megadott MU-kat hozza 

létre véletlenszerűen a megadott módon.
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Source – MU típus megadása

Az MU kiválasztásához ki

kell választani az MU

melletti hárompontos

gombra:

A Select Object

párbeszédablakban ki

kell választani az MUs

mappát.

A kibocsátandó MU típusát ki kell választani ebből a mappából. Itt találhatók meg a

felhasználó által definiált MU típusok is.
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Az Entity - elem

• Ikon:

• Kapacitás: 0

• Mozgó anyagáramlás objektum 

(MU)

Jellemzők :

Az Entity egy olyan objektum, amit

a Source hoz létre, az

anyagáramlás objektumok

dolgoznak fel, és a Container és

Transporter objektumok szállítanak.

Az Entity nem szállíthat, nem

tartalmazhat másik alkatrészt vagy

elemet.
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• Ikon:

• Kapacitás: 1

• Aktív anyagáramlás objektum

A SingleProc – az egyszerű folyamat

Jellemzők :

Egy MU-t fogad, feldolgozza azt,

és továbbmozgatja a következő

állomásra az anyagáramban. Ha

az MU típusa különbözik a korábbi

típustól, akkor a SingleProc

objektumot fel kell készíteni a

feldolgozására.
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A Drain – a csatorna

• Ikon:

• Kapacitás: 1

• Aktív anyagáramlás objektum

Jellemzők :

Eltávolítja az MU-t az

anyagáramból amint a

megadott set-up time (beállítási

idő) és processing time

(feldolgozási idő) eltelik.
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Drain - statisztikák

A Drain statisztikát készít az 

érkezett MU-król.

Az MU statisztikai adatai ás a 

teljes statisztika 

megjeleníthető, illetve MU 

típus szerint is kinyerhető
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EventController – eseményvezérlő 
beállítások

• Ikon:

Jellemzők :

Az EventController koordinálja és szinkronizálja a

szimuláció futása közben történő eseményeket.

A Settings fülön megadható a szimuláció

kezdődátuma (Date) és az idő, amikor

befejeződik (End).

Az időpont megadásakor az EventController

törli a statisztikákat, és újrakezdi a statisztikai

adatok gyűjtését. A Statistics mezőben

megadható, hogy a szimuláció futása során

mikortól kezdődjön a statisztikai adatok

gyűjtése.
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EventController - vezérlők

A metódusok a Init gomb lenyomásakor kezdenek el lefutni, és befejeződnek mielőtt a modell

inicializálódna. A Plant Simulation inicializálja a szimulációs modellt, mielőtt a következő

esemény lefutna.

A szimuláció a Start gombbal indítható el. Ha ez az első futása a szimulációnak, vagy előtt

lenyomta a Reset gombot, a Plant Simulation lefuttatja az összes Init metódust a modellben.

Az aktív események feldolgozása után a szimuláció a Stop gombbal állítható meg. Újraindítani

a Start gombbal lehet.

A szimuláció lefuttatható az egyes eseményeken végighaladva lépésről lépésre is (Step).

A szimulációs modell a Reset gombbal állítható alaphelyzetbe.

A Plant Simulation meghívja az összes Reset nevű metódust

az aktív modellben. Ez törli a fel nem dolgozott eseményeket,

visszaállítja a szimuláció idejét 0-ra, alaphelyzetbe állítja a

statisztikákat, és eltávolítja a gépek esetleges hibáit.

A szimuláció az Init gombbal inicializálható, ekkor lefut az

összes Init nevű metódus.

A Controls fülön lehet megadni a szimuláció sebességét, és vezérelni a szimulációt.
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Toolbox (komponens paletta)

A Toolbox azoknak a Plant Simulation eszköztáraknak a tárolója, 

amelyek a Class Library objektumait tartalmazzák. 
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Komponens beillesztése Frame-be

Objektum beillesztése a

palettáról Frame - be:

• A megfelelő objektum ikonját

tartalmazó fül/eszköztár

kiválasztása.

• Ikonjára kattintással a

kiválasztása.

• Az egér mozgatás a megfelelő

Frame - be, és kattintás az

objektum elhelyezéséhez.

Ha egy objektumból többet kell beilleszteni, akkor az egér kattintás közben nyomva kell 

tartani a Ctrl billentyűt. Ekkor nem kell a palettához visszamenni minden egyes elem 

beillesztéséhez. Ebből a másolás módból jobb egérkattintással lehet kilépni a Frame - en 

belül.
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Objektum beillesztése a Class Library-ből a 
Frame-be

Az objektumok húzd és ejtsd módszerrel is beilleszthetők a

Frame-be a Class Library-ból áthúzva azokat a Frame területére.
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Objektumok összekötése

A connector (összekötő)

objektum különbözik a többi

Plant Simulation objektumtól,

mert nem használható külön

objektumként, csupán más

objektumok összekötésére.
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Objektumok összekötése Connectorral

A és B objektum

összekötéséhez ki kell

választani a Connector

objektumot a palettán,

és kattintani kell először

az A, majd a B

objektumon.

Nem egyenes összekötés készítéséhez meg kell adni

a töréspontokat is. Először kattintani kell az A

objektumra, majd a töréspontok helyére és végül a B

objektumra. Később a töréspontok helye vonszolással

módosítható.
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3. lecke

A gyártólétesítmény modellezése

1. Nyissa meg a Frame

objektumot a Models

mappában.

2. Nevezze át Plant_1

névre.

3. Illessze be a szükséges

objektumokat és kösse

azokat össze.

4. Módosítsa a Milling objektum feldolgozási idejét (processing time) 8

percre.

5. Nyissa meg az EventController objektumot, és kattintson a Reset gombra

először, majd a Start gombra a szimuláció elindításához.
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Állapot megjelenítése LED-del

Az anyagáram objektumok LED - del jelzik az ikonjuk felső kerete mentén az adott

objektum állapotát. A LED egyszerre többféle állapotot is jelezhet, az állapotjelző

ikonok viszont csak egy állapotot tudnak egy időben jelezni..

Az alábbi színek a következő állapotokat jelzik:

vörös az objektum meghiúsult vagy hibás (failed).

kék az objektum szünetel (paused).

zöld az objektum működik, dolgozik (working).

sárga az objektum blokkolt (blocked).

barna az objektum beállítás alatt (setting-up) (setUp).

vil. kék az objektum helyreállítás alatt (recovering)

(no_entry).

Az alapértelmezett állapot ikon nem jelenít meg semmilyen színes jelet.
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A Frame eszköztára

Zoom In/Out

Kicsinyítés, 

nagyítás

Show Unconnected Objects

Nem kapcsolódó objektumok 

mutatása

Reset

Visszaá

llítás

Open 

EventController

Eseményvezérlő 

megnyitása

Start/Stop

Indítás/

megállítás

Start Without 

Animation

Indítás 

animáció nélkül

Delete 

Törlés

Delete Moving Units

Mozgó elemek törlése

Show Names 

/ Nevek 

mutatása

Show 

Connections

Összekötések 

mutatása

Show Comments

Megjegyzések 

mutatása

Show Grid

Rács 

mutatása

Modify 

Structure/ 

Struktúra 

módosítása
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Modellezési beállítások –
Options – Modeling fül

A Frame beállításai a menüben:

Tools > Options > Modeling

(Eszközök > Beállítások > Modellezés)

Ezek a beállítások elérhetők a Frame

ablakában a View > Options (Nézet >

Beállítások) menüpont alatt is.

Javasolt a Delete objects > Confirm

(Objektumok törlése > Nyugtázás) opció

bekapcsolása, mivel az objektumok

törlése nem vonható vissza.

Általánosságban az új beállítások a Plant Simulation újraindítása után

érvényesülnek. Bizonyos beállítások azonban, mint például a mértékegységek

módosítása azonnal érvényesülnek.
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Beállítások a Frame menüjében

Minden egyes Frame - re külön

megadhatók beállítások a

menüben:

View > Options (Nézet >

Beállítások)

A globális beállításokat pipa

jelöli a menüpont bal oldalán.

User Menu (felhasználói menü) és Shortcut Menu (helyi menü) és a nem összekötött

objektumok megjelenítésére: Showing unconnected objects.
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A Frame Icons (ikonok) menüje

Megadható az ikonok helye, a helyzete, a mérete és szerkeszthetők (Edit icons) az

ikonok.

Az Icons (ikonok) menü csak akkor aktív, ha ki van választva objektum a Frame-

ben.

Mirror Vertically – Tükrözés

függőlegesen

Mirror Horizontally – Tükrözés

vízszintesen

Rotate – Forgatás

Reset – Visszaállítás

Enlarge (x2) – Duplára növelés

Original size – Eredeti méret

Reduce (/2) – Felére csökkentés
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Objektum neve és címkéje

Az objektumokra a nevük

(Name) mellett egy címke

(Label) is megadható. A

neveknek eleget kell tenni a

megnevezési szabályoknak,

míg a címkék tetszőleges

szöveget tartalmazhatnak.

Az objektumok nevének és címkéjének kiíratása be, illetve kikapcsolható a menüből:

View > Options > Show Object Names (Nézet > Beállítások > Objektum nevek

mutatása)

és/vagy

Show Object Labels (Objektum címkék mutatása)
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Hogyan dolgozzunk a leckékkel?

Általában a leckék az előző modellezési lecke eredményéből indulnak ki, például

ez a lecke az előzőekben megadott Frame - et használja a kezdéshez.

Hogy leckénként szét tudjuk válogatni a lépéseket, először egy másolatot

készítünk az eddig elkészítettekből a Class Library > helyi menü > Duplicate

(Másolat készítése) parancsával. Ez után a Frame átnevezhető (helyi menü vagy

F2 billentyű) és átmozgatható másik mappába a Shift billentyűt lenyomva tartva

az egérrel vonszolás során.

Ez a technika a valós

életben is jól használható a

projekteknél.
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Frame tartalmának másolása

Másolja Vágólapra a Frame egész

tartalmát és illessze be ugyanabba és egy

másik Frame-be.

Kattintson az egér bal gombjával és

téglalap kijelöléssel válasszon ki

tetszőleges objektumokat.

Másolja ezeket az objektumokat a

vágólapra az Edit > Copy (Szerkesztés >

Másolás) (vagy Ctrl+C) paranccsal.

Illessze be a vágólap tartalmát az Edit >

Paste (Szerkesztés > Beillesztés) (vagy

Ctrl+V) paranccsal tetszőleges helyre és

tetszőleges Frame-be.
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4. lecke

Menüparancsok használata objektumok megjelenítésére a 

Frame - en belül

Másolja át a Plant_1 Frame tartalmát egy új

Frame-be az Exercises (Frame_1) mappába.

Gyakorolja az objektumok megjelenítésének

különböző módjait, a nagyítást, forgatást és

mozgatást, objektumok összekötését

egyenes és nem egyenes összekötő

elemekkel, és objektumnevek és címkék

megadását és megjelenítését.

Keresse meg, hogy melyik nyomógomb tartozik a Frame eszköztáron az

EventController objektumhoz.
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7. fejezet

Anyagáram megadása, statisztikák, 

grafikonok
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Gyár elrendezés

CutToSize

Méretrevágás

Milling1

Marás 1

Paintshop

Festőüzem

Quality

control

Minőség-

ellenőrzés

Packing

Csomagolás

Receiving

Table-Legs

Asztallábak érkezése

Milling2

Marás 2

Shipping

Szállítás

Buffer

Tároló

Assembly

Szerelés
Conveyor - Szállítószalag

Rejects

Selejt

Store

Table-Tops

Asztallapok tárolása
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Második marógép hozzáadása

A 8 perces feldolgozási idővel rendelkező marógép az

üzemünk legszűkebb keresztmetszete.

Megoldásként hozzáadunk még egy marógépet a sorhoz,

és azt az elsővel párhuzamosan helyezzük el. Ennek a

gépnek a feldolgozási ideje 3 perc lesz.
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Anyagáram szétosztása

Illesszünk be egy második marógépet (SingleProc) a

modellbe, és kössük össze azt a többi géppel Connector -

okkal.
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5. lecke

Anyagáram szétosztás és egyesítés

1. Másolja a Plant_1 objektumot és nevezze el Plant_2-nek.

2. Készítsen egy második marógépet (SingleProc) aminek a

neve legyen Milling2.

3. Válassza ki a View > Options > Show Successors

(Nézet > Beállítások > Utódok mutatása) menüpontot a

Frame menüjében.

4. Indítsa el a szimulációt és csökkentse a

sebességét.

5. Figyelje meg, hogyan mozognak az MU-

k az egyik állomásról a másikra.
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Az MU-k alapértelmezett mozgása 
állomásról állomásra

successor(1)
utód(1), 
kimenő ág

successor (3)

Diverging
Szétosztás

successor (2) 

1

2

3

predecessor (1)
előd (1),
bemenő ág

predecessor (3)

Converging
Egyesítés

predecessor (2)

1

2

3

1

Az alapértelmezett stratégia anyagáram szétosztásakor a nem-blokkolás: a Plant

Simulation az MU-kat a successor -ok sorrendjében küldi tovább. Ha egy

successor foglalt az MU vár addig amíg a successor szabaddá válik az MU

fogadására.

Amikor egyesül az anyagáram, a Plant Simulation az MU-kat az érkezési

sorrendben küldi tovább, amelyik először érkezik az először távozik. Ha az ág

foglalt, akkor az MU bekerül a Forward Blocking listájába az adott ágnak.
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Kilépési stratégiák

A kilépési stratégia az anyagáram

objektum Exit Strategy (Kilépési

stratégia) fülén választható ki listából.

A kilépési stratégia határozza meg, hogy

milyen módon küldi tovább az objektum

az MU-kat.

A Cyclic (periodikus) stratégia az

alapértelmezett. A Blocking (blokkolt),

esetben csak akkor megy tovább az MU,

ha a következő objektum fogadó ága

készen áll az MU fogadására.

Ha a Blocking opció ki van kapcsolva,

akkor bármely fogadó ág szabaddá

válásakor tovább mozog az MU.
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FlowControl –
az áramlás kontrollálása

• Ikon:

• Kapacitás: 0

• Anyagáram objektum

Jellemzők :

A FlowControl szabályozza az

anyagáramlást, meg lehet adni egy

kilépési stratégiát az áramlás

szétosztására, vagy egy belépési

stratégiát az anyagáramlás

egyesítésére.

Példa: Percentage strategy (százalékos

stratégia)
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6. lecke

FlowControl, Exit Strategy (kilépési stratégia), 

Percentage Strategy (százalékos stratégia)

3. Válassza ki a Percentage stratégiát és kapcsolja be a Blocking opciót:

Milling1 kapja 27%-át, Milling2 a 73%-át a mozgatott MU -knak.

1. Másolja a Plant_2

objektumot és nevezze át

Plant_3 névre.

2. Illesszen be egy

FlowControl objektumot a

CutToSize és a két marógép

állomás (Milling1 és Milling2)

közé.

A FlowControl kontrollálja az anyagáramlást az ez egyik állomásról a

másikra.
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Statisztikák gyűjtése

• Resource statistics: A következő típusú anyagáram objektumok: Production,

Container és Transporter.

• Product statistics: Minden mozgó objektum.

• Driving statistics: Transporter.

• Complete statistics: Minden anyagáram objektum és minden mozgó objektum

beírja a statisztikai értékeit a teljes statisztika táblájába.

Statisztikák különböző típusai:

A típusuktól függően az anyagáram objektumok és az MU-k különböző típusú

statisztikai értékeket gyűjtenek össze:
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Statisztika táblázatok

Minden objektum gyűjt magáról statisztikai

értékeket. Ez kikapcsolható a Statistics

(Statisztika) fül Resource statistics / Product

statistics (Erőforrás / termék statisztika)

opciójával.

A Plant Simulation a legfontosabb statisztikai

értékeket a Statistics vagy Product

statistics fülön mutatja.

Minden anyagáram objektum és minden

mozgó objektum beírja a statisztikai értékeit

a Resource Statistics Table, a Product

Statistics Table vagy Complete Statistics

Table táblákba.
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Statisztika értékek

Az EventController Reset gombjára kattinva a Plant Simulation az összes

statisztikai értéket nullára állítja vissza.

Rákattintva a View, Statistics Report menüpontra gombra, a Plant Simulation

megnyit egy táblázatot, amely tartalmazza az összes értéket, amely összegyűlt a

szimuláció futása során. A különböző értékek részletes leírását a Súgó tartalmazza

a Statistics Table téma alatt.

A különálló statisztikai értékek a statisztikai metódusok révén érhetők el, az ilyen

függvények neve „stat...“ kifejezéssel kezdődik.
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• Ikon:

• Kapacitás: 0

• Felhasználói felület objektum

Chart - grafikon

Jellemzők :

A Chart (grafikon)

statisztikai adatok

megjelenítésére szolgál,

és lehetővé teszi az

aktuális értékek és a

szimulációs eredmények

gyors elemzését.

99
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Chart–Data Source (adatforrás)

A rádobott objektum típusától függően a

grafikon állapotjelzőként (state chart)

működik, mutatva a megfelelő anyagáram

objektum állapotát.

Ha az első rádobott objektum egy buffer

(puffer) objektum volt, akkor a grafika

histogram (oszlopdiagramm) lesz.

A grafikon plotterként is használható.

A Chart objektumot be kell szúrni a Frame-be. Aztán az anyagáram objektumot,

amelynek a statisztikáját meg szeretnénk jeleníteni, rá kell dobni a Chart

objektumra.
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7. lecke

Statisztikák és grafikon

1. Aktivizálja a statisztikák

gyűjtését a két marógépre.

2. Illesszen be egy Chart

objektumot a Plant_3 Frame-be.

3. Dobja rá a Milling1 és Milling2

objektumokat a Chart

objektumra.

4. Nézze meg a statisztikát a

szimuláció futása során.
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8. fejezet

A modell hierarchikus szerkezete
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Hierarchia – Mi is ez?

A hierarchia az a koncepció, ahogy a

Frame-ek egymásba ágyazhatók. Ezzel a

módszerrel különálló komponensek

modellezhetők és tesztelhetők.

Egy Frame kombinálhat egy vagy több

komponenst, és a komponensek a

modellbe tetszőleges számban

beilleszthetők.

A saját fejlesztésű objektumok ugyanúgy

használhatók, mint a beépített objektumok, és

felhasználhatók más modellekben is.

A hierarchikus modellezés könnyen áttekinthetővé is

teszi a modellt.
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Komponens készítése

A komponenst a Class Library-n belül

egy új Frame-ként modellezzük, és

elhelyezzük rá az objektumokat,

amelyekre szükség lesz ehhez a

modulhoz.

Ez után a komponenst beillesztjük a

szimulációs modellbe és úgy

használjuk, mint bármely beépített

objektumot, akár másik projektekben

is.

A komponens elmenthető

objektumként, ami más projektekbe

betölthető.

Az Interface (interfész) objektum adja

meg, hogy a Frame melyik oldalán lép

be az anyagáram és melyiken lép ki.
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Az Interface (interfész)

• Ikon:

• Kapacitás: 0

• Anyagáram objektum

Jellemzők :

Az Interface modellezi a kapcsolatot Frame

és anyagáram objektumok között. Megadja

azt is, hogy melyik oldalon csatlakozik a

Connector objektum hozzá.

Oldal (Side) kiválasztás: Left (bal), Right (jobb), Top (felül) vagy Bottom (alul)

ahol az ikonon a Plant Simulation megjeleníti a belépést és a kilépést a Frame

objektumon. Megjegyzendő, hogy a Plant Simulation a Side (oldal) beállítást csak a

megjelenítés céljára használja.
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A szimulációs modell moduljának 
tesztelése

A komponens (felhasználói által definiált objektum) funkcióját le kell tesztelni,

mielőtt a modellbe illesztésre kerülne.
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A modell hierarchikus szerkezete

Felhasználói komponensek segítségével modellezhetők a szimuláció objektumai. A

komponensekhez ikonok készíthetők, és az elkészült komponensek beilleszthetők a

modellbe, mint bármely anyagáram objektum. Az elkészült komponensek

felhasználhatók más szimulációs modellekben is.

A komponensekkel történő modellezés könnyebben áttekinthető szerkezetet ad a

szimulációs modellnek.
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8a lecke

Modul a szimulációs modellben

1. Készítsen egy új Frame-et a

FacilityComponents mappában, és

legyen a neve: CompMilling.

2. Másolja át a FlowControl, Milling1 és

Milling2, és Chart objektumokat a

Plant_3 objektumról a CompMilling

Frame-re.

3. Illesszen be két Interface (interfész)

objektumot. Válassza ki a megfelelő

Side oldalt, ahol a Connector objektum

kapcsolódik.
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8b lecke

1. Készítsen egy új Frame -et a

TestModel mappában, és legyen a

neve: TestMilling.

2. Illesszen be egy Source, egy Drain,

egy EventController objektumot, dobja

be a CompMilling Frame -et a

FacilityComponents mappából a

Source és a Drain közé. Kapcsolja

össze őket Connector objektumokkal.

3. Tesztelje a funkcionalitást. Nyissa

meg a CompMilling Frame -et és nézze

meg mi történik benne.

A modell/teszt környezet hierarchiája

Ne feledje, hogy a CompMilling komponensen változtatásokat csak a Class

Library - ben végezzen a FacilityComponents mappában.
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8c lecke

Miután bebizonyosodott, hogy a CompMilling Frame a várt módon működik, be

lehet illeszteni a modellbe.

A modell hierarchiája

1. Készítsen másolatot a

Plant_3-ból és legyen a

neve Plant_4.

2. Törölje a FlowControl és

mindkét marógép

komponenst, és illessze be

a CompMilling Frame

komponenst a

FacilityComponents

mappából.

3. Kösse össze a Frame -et a

többi komponenssel, és

futtassa a szimulációt.
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Felhasználói objektumok újra felhasználása

A komponensek vagy mappák objektum fájlként

elmentetők *.obj kiterjesztéssel:

Jobb klikk a komponensen > Save Object As

(Objektum mentése másként)

Más projekt osztály könyvtárába (Class Library) a

komponens beszúrható:

Jobb klikk > Load Object (Objektum betöltése)

Ha a névvel megegyező nevű objektum már

létezik a Class Library-ban, akkor megadható,

hogy felül kívánja - e írni a meglévő objektumot

az újjal, vagy az új objektum más néven kerüljön

be a modellbe.
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9. fejezet

Az ikonszerkesztő
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A szimulációs modell grafikus kiértékelése

A Plant Simulation ikont használ az objektum megjelenítésére a következő

helyeken: Class Library, Toolbox, és Frame. Az ikonok alkalmasak az objektum

műveleti állapotának kijelzésére is, pl: failed, paused, stb. A beépített ikonok

módosítása, beleértve az animációs útvonalakat is, és új ikonok készítése az Icon

Editor (ikon szerkesztő) segítségével lehetséges.
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Az ikonszerkesztő

Az Icon Editor megnyitása

Helyi menü > Edit Icons (Ikonok szerkesztése)

Az ikon egy osztálytulajdonság, ezért egy

objektumnak a Class Library-ben és mindenhol

máshol, ahol előfordul, azonos ikoncsoportja van.

Az ikon módosítása egy helyen a teljes objektum

osztályban történő megváltozását okozza!

A beépített ikonok módosítása az összes objektumra, és új ikonok hozzáadása.

Emellett megadhatók animációs pontok/útvonalak az anyagáram objektumokra, az

MU-kra és a Frame-ekre.
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Az ikonszerkesztő

Színpaletta

Rajzablak

A jelenlegi ikon 

aktív ikonná tétele

Az ikon neve

Aktív rajzszín

Átlátszó szín

Eredeti méret

Ikon 

sorszáma

Referencia-

pont
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Az ikonokról

• Tetszőleges számú ikon definiálható egy objektumra. A Plant Simulation a

Frame-ben az objektumot az Active (aktív) ikont jeleníti meg.

• A Plant Simulation a Toolboxban a 0-ás és Default nevű ikont jeleníti meg 40 x

40 képpont méretben. Ezek az ikonok módosíthatók.

• A Frame-hez hozzáadható egy ikon Background névvel, amit a Plant Simulation

a Frame háttérképeként használ.

• Az ikonok maximális mérete 4000 x 4000 képpont.

• Az ikon jellemzők osztályszintű jellemzők.

• Az ikon animáció és az MU animáció aktivizálása csökkenti a teljesítményt.

• A Plant Simulation nem tartalmaz beépített állapotikonokat!
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Automatikus átkapcsolás ikonok között

Az anyagáramlás és a mozgó objektumok képesek automatikusan változtatni az

ikonjukat az állapotuk változása esetén. Ez csak akkor működik, ha az egyes

állapotokhoz vannak ikonok definiálva az alábbi nevekkel:

Anyagáram objektumok és Transporter:

• failed

• paused

Mozgó objektumok és Transporter:

• operational

• waiting

Anyagáram objektumok:

• working

• setUp

• no_Entry

Az állapotikonok használata engedélyezhető:

Icons > Use State Icons (Ikonok > Állapot ikonok használata)

az ikonszerkesztőben.
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Az ikonszerkesztő eszköztár

Drawing tools

Rajzeszközök

Freehand/Szabadkéz

Line/Vonal

Polyline/Polivonal

Ellipse/Ellipszis

Rectangle/Téglalap

Filled Rectangle/Kitöltött téglalap

Fill Area/Terület kitöltése

Copy Area/Terület másolása

draw/delete

rajzol/töröl

Draw Mode

Rajz mód

Animation Mode

Animáció mód

Previous / Next Icon

Előző/Következő ikon

EyedroEyedropper

Szemcseppentő

Delete All

Mindent 

töröl

Set Reference Point

Referenciapont 

megadása

Zoom In / 

Zoom Out

Nagyítás / 

kicsinyítés

Apply Changes

Változtatások 

alkalmazása
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Új ikon készítése

2. Új üres rajzterület megnyitása az

új ikon számára

Icon > New (Ikon > Új)

(Ha szükséges, definiálja az ikon

méretét (Size).

3. Nyissa meg a Clipart Library-t:

Tools > Clipart Library

(Eszközök > Képelem könyvtár).

1. Icon Editor megnyitása (helyi

menü a Class Library-ban vagy a

Frame-ben az Edit Frame Icons

parancs).
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Új ikon készítése

Illessze be ezt az ikont a Training könyvtárból húzd és ejtsd módszerrel.
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Rajzolás – képpontok, vonalak, terület 
kitöltése

A színpalettáról ki lehet választani egy színt az

előre definiált színek közül.

Freehand drawing (szabadkézi rajz)

A Freehand (szabadkézi) funkcióval a

rajzterületen kattintva pontok rajzolhatók, amik az

ikont meghatározzák.

Alakzatok rajzolása

Kattintson a rajzolni kívánt alakzat

nyomógombjára, kattintson egyszer az alakzat

alappontjának megadásához, tartsa lenyomva az

egér gombját, és mozgassa, amíg az alakzat a

kívánt méretet ölti fel.

Fill Area (Terület kitöltése)

Kattintson a Fill Area gombra, majd a kitölteni kívánt területen belül az aktív rajzolási

színnel történő területkitöltéshez.
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Rajzolás – referenciapont megadása, 
szemcseppentő

Eyedropper (szemcseppentő)

A rajzolási szín beállítható az Eyedropper eszközzel. A kiválasztása után arra a

színre kell kattintani a rajzablakban, amelyet rajzszínként kíván használni.

Referenciapont megadása/mozgatása

Minden ikonnak van egy referenciapontja.

A Plant Simulation ezt használja az

objektum pozícionálásához, amikor egy

Frame-be beillesztésre kerül.

Alapértelmezett helye a referenciapontnak

a bal felső sarka az ikonnak.

A referenciapont máshova mozgatásához

a Set Reference Point gombra, majd a

rajzablakban a referenciapont új helyére

kell kattintani.
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Ikon mentése

Mielőtt a változásokat alkalmazza az új

vagy módosított ikonra, győződjön

meg, hogy megadta a megfelelő

Name (Név)

Tulajdonságot az ikonra és bejelölte a

Current (Jelenlegi)

Tulajdonságot, hogy a Plant Simulation

ezzel az ikonnal jelenítse meg az

objektumot.

Közvetlenül kilépve az ikonszerkesztőből a változások mentésére Yes (Igen) választ

kell adni.

Az ikon elmenthető Eszközfüggelten bitképként (.dib), és Hordozható hálózati

képként (.png) is a File > Save vagy File > Save As menüparancsokkal.
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Ikonok animálása

Ahhoz, hogy az anyagáram objektum ikonokon az MU-k ikonjai is megjelenjenek,

animációs pontokat (animation point) kell megadni.

Az animációs pont egy olyan referenciapont, amihez az MU illeszti a saját

referenciapontját amikor az objektumon megjelenik, vagyis ahol az MU megjelenik

az animáció során. A hossz-orientált objektumokra animációs vonal is megadható.

Az animációs pontok/vonalak beillesztéséhez az ikonszerkesztőben az Animation

mode (Animációs mód) gombra kell kattintani az eszköztáron.
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Animációs mód

Animation mode

Animációs mód

Freehand

Szabadkéz

Line

Vonal

Delete / Törlés

Link/ Unlink Animation Point

Animációs pont csatolása/csatolás eltávolítása

Move Animation Point

Animációs pont 

mozgatása
Polyline

Polivonal 

• A rajzeszközök használhatók az animációs pontok

és animációs vonalak megadásához.

• A Connector objektum használható az objektumok

és a komponenseket tartalmazó Frame-ek

összekötésére.

• A törlés eszközökkel lehet az animációs pontokat

és vonalakat törölni.
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Animációs pontok megadása

1. Kattintson az Animation Mode

gombra.

2. Rajzoljon animációs pontot vagy

vonalat.

3. Kattintson a Link/ Unlink Animation

Point gombra és kattintson az

animációs pontra vagy vonalra.

Ekkor megnyílik a kapcsolódó

Frame.

4. Válassza ki azt az állomást,

amelyhez hozzá kívánja rendelni az

animációs pontot. A Plant Simulation

az állomás nevét címkeként

hozzárendeli az animációs ponthoz.
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Ikonok a palettán

A Toolbox (paletta) ikon módosításához a 0-ás

sorszámú és Default nevű ikont kell szerkeszteni

(maximum 40 x 40 képpont méretű!).

A definiált komponensekhez új eszköztárak

adhatók

Helyi menü > New > Toolbar (Új > Eszköztár)

A beépített eszköztárak kibővíthetők vagy

módosíthatók:

Tartsa lenyomva a Shift billentyűt, és húzza az

objektumot az eszköztár ikonra és engedje fel

az egérgombot.

Objektum vagy osztály megnyitható, eltávolítható az eszköztárról a

helyi menüjéből.
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9. lecke

Ikonok módosítása, animációs pontok megadása

1. Nyissa meg az Icon Editort a CompMilling Frame-re a

FacilityComponents mappában.

2. Válassza ki az Icons > New menüpontot és a marógép ikont a Clipart Library -ből.

3. Kattintson az Animation Mode gombra és adjon meg két animációs pontot a gép

ikonján. Kattintson a Link/Unlink Animation Point gombra, és csatolja az

animációs pontokat a Milling1 és Milling2 objektumokhoz a Frame-ben.
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Az animációról

Alkatrészek animálása felhasználó által definiált MU ikonokon

A Plant Simulation az MU-k

referenciapontját hozzáilleszti az

anyagáram objektumok

referenciapontjához.

Saját MU ikon készítésekor, ha azok

más MU-kat is tartalmaznak, meg kell

adni animációs pontokat, hogy a Plant

Simulation megfelelően tudja animálni

azokat.
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Az animációról

Annak megmutatására, hogy miképpen

mozog az MU a hossz-orientált

objektumokon (Line, Track, Buffer,

PlaceBuffer), meg kell rajzolni az animációs

vonalat az ikonon.

Ez után meg kell adni az animációs lépések

számát a menüben:

Tools > Number of Events (Eszközök >

Események száma)

menüpont alatt. Az animációs események

száma megadja, hogy a Plant Simulation

milyen sűrűn mutatja az MU-t a hossz-

orientált objektumon a szimuláció futása

során.

Animáció a hossz-orientált objektumokon
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10. fejezet

Osztályok, példányok és öröklődés
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Öröklődés

Az objektum orientált programok egyik legfontosabb jellemzője az Öröklődés

(Inheritance).

Minden Plant Simulation objektum a Class Library-ben egy osztály.

Ezek az osztályok kibővíthetők, és készíthetők új osztáyok, amelyek

jellemzőket örökölhetnek a szülő osztályuktól.

Osztály objektumokat használva a szimulációs modellben, használható az

öröklődés mivel az osztály összes jellemzője átöröklődik az objektumokba,

amelyek belőle származnak.

Ha egy jellemző az osztályban módosul, akkor az összes az osztályból

származtatott objektumban is megváltozik. Ez sokkal biztonságosabb és

hatékonyabb, mint egyesével megváltoztatni az adott tulajdonságot minden

előfordulásban.
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Osztály: Minden objektum a Class Library-ben osztály. Ezek sablonokként

működnek azon példányokhoz, amelyeket a Frame - ekbe be lehet

illeszteni.

Alosztály: Olyan objektum a Class Library-ben, amely a legfontosabb jellemzői

más osztálytól származtatódnak. Minden egyéb tulajdonság erre az

alosztályra jellemző.

Példány: A példány vagy előfordulás egy a szimulációba illesztett objektum a

Class Library - ből vagy a Toolbox - ból.

Öröklődés: Az osztály az összes jellemzőjét átadja a belőle származtatott

alosztálynak vagy példánynak. Az öröklődés csak az osztálytól az

alosztály és példány irányába működik, a másik irányba nem!

Ha egy tulajdonságot az összes példányban módosítani kell, akkor az

osztály objektumot érdemes módosítani.

Fogalmak
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Példa osztályra és példányra

A Milling osztály a Class Library-ban.

A belőle származtatott példány beillesztve

a TestMilling Frame-be.

Class

Osztály

Instance

Példány
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Példa osztályra és alosztályra

A Line osztály megadja az objektum jellemzőit, mint

például a hossz, a végsebesség, a kapacitás, stb.

Készíthető két további hasonló objektum, amelyeknek

a hossza különbözik. Minden más jellemző ugyanaz

marad.

A hosszra (Length) ki kell kapcsolni az Öröklődés

(Inheritance) gombot, kikapcsolt állapotban nem örökli

a tulajdonságot. Ezen kívül minden más jellemzőt a

Class Library Line osztályától örököl.
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Öröklődés

A Line objektum helyi menüjéből a

Derive (származtatás) parancsot

kell kiválasztani az osztály egy

alosztályának elkészítéséhez. Az

alosztály az osztálytól örökli a

jellemzőinek nagy részét.

A Line objektum helyi menüjéből a

Duplicate (másolás) parancsot

kell kiválasztani egy új osztály

készítéséhez. Minden öröklődési

kapcsolat az osztály és a másolat

osztály között megszűnik, csak

átmásolódnak a jellemzők.
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Öröklődés – Példa

Készítsen egy másolat

Milling és egy alosztály

Milling osztályt a Frame

Milling osztályból a Class

Library-ben.

Ez a három objektum

azonos struktúrát képvisel.

Most módosítsa a Milling

osztályt, még egy marógép

hozzáadásával.
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Öröklődés – Példa

Mivel az öröklődés aktív,

minden változás, ami az

osztályban történik, öröklődik

az alosztályba is.

A másolat viszont nem érintett

ezek által a változtatások által,

mivel az öröklődés a másolat

esetében nem érvényesül.
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Öröklődések felismerése – Frame

Az Open Origin (Eredet megnyitása)

akkor aktív a Frame eszköztáron, ha az

objektumnak van szülője.

A gombra kattintva a Plant Simulation

megnyitja a Frame szülőjét.

Ez azt jelenti, hogy a Plant Simulation az

ezen a szinten végrehajtott módosításokat

az innen származtatott hierarchikus

szintekre továbbvezeti.

A Plant Simulation az Interface objektum

ikonját kitöltött fekete színben mutatja, ha

Connector objektum kapcsolódik a Frame

-hez.
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Öröklődések felismerése – Objektumok

A párbeszédablak elem melletti

kapcsológomb állapota mutatja,

hogy az öröklődés aktív vagy

nem.

A mínusz jeles gomb azt jelenti,

hogy az öröklődés nem aktív. A

megadott értékek csak a

jelenlegi objektumra

vonatkoznak, az osztály

példányára, és nem az egész

osztályra.

A mínusz jel nélküli gomb azt

jelenti, hogy az öröklődés aktív.

Ekkor az objektum örökli a

szülőjétől az értéket.
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Öröklődési struktúrák mutatása

A Navigate (Navigálás) menü alábbi menüpontjai használhatók az öröklődési

struktúrán történő végighaladásra.

• Open Location (Hely megnyitása): annak a

mappának a megnyitása a Class Library-ben, ahol az

objektum található.

• Open Origin (Eredet megnyitása): az objektum

szülőjének megnyitása, ami a következő szint fölfelé

az öröklődési struktúrában.

• Go To Orgin (Eredetre váltás): a szülő objektum

megnyitása és a példány bezárása.

• Open Class (Osztály megnyitása): az objektum

osztályának megnyitása

• Go To Class (Osztályra váltás): az objektum

osztályának megnyitása, és a példány bezárása.

Ha nincs magasabb szintű öröklődési elem akkor csak az Open Location

menüparancs aktív.
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Öröklődési stuktúrák mutatása

• Show Origin (eredet mutatás): a kiválasztott

objektum szülőjének mutatása.

• Show Structure (struktúra mutatása): a

Structure ablak megnyitása, ami a kiválasztott

Frame struktúráját mutatja az összes benne

lévő objektum nevével.

• Show Inheritance (öröklődés mutatása): az

Inheritance (öröklődés) ablak megnyitása, ami

mutatja az objektumok útvonalát, amelyek ebből

az objektumból származnak.

* A Frame is egy objektum.

Az alábbi parancsok valamelyike használható az öröklődési struktúra ablakban

történő megjelenítéséhez.
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11. fejezet

Adattípusok,

Egyéni jellemzők,

Táblázatok



www.graphit.hu

Gyártóüzem elrendezése

CutToSize

Méretrevágás

Milling1

Marás 1

Paintshop

Festőüzem

Quality

control

Minőség-

ellenőrzés

Packing

Csomagolás

Receiving

Table-Legs

Asztallábak érkezése

Milling2

Marás 2

Shipping

Szállítás

Buffer

Tároló

Assembly

Szerelés
Conveyor - Szállítószalag

Rejects

Selejt

Store

Table-Tops

Asztallapok tárolása
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A feladat

A festőüzem az asztallapokat a festés

minősége szerint válogatja szét: jó vagy rossz

kategóriába.

Szimulálni kellene a 10%-os visszaküldési

arányt.

Ebből a célból az asztallapokhoz hozzá kell

adni egy jellemzőt, ami a festés minőségét

jelzi: minden tízből egy asztallap rossz kell,

hogy legyen.

A festőüzem ellenőrzi ezt a jellemzőt, és ettől

függően küldi tovább az asztallapot.

Ehhez többet kell tudnunk az adattípusokról,

táblázatokról, és a FlowControl objektumról.
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Attribútumok

Minden Plant Simulation objektumnak vannak beépített attribútumai (pl.: hossz,

sebesség, kapacitás, név, stb.) és metódusai (pl.: createAttr, closeDialog,

moveToFolder, stb.).

Az attribute (attribútum) adja meg egy objektum viselkedését, vagy állapotát. A

method (metódus) információt gyűjt ki az objektumról, és egy értékkel tér vissza.

Értéket számít ki, vagy módosítja az objektum viselkedését.

A Show Attributes and Methods (Attribútumok és metódusok mutatása) ablak az

objektum beépített attribútumait és metódusait jeleníti meg. Az objektum helyi

menüjéből nyitható meg

• Show Attributes and Methods paranccsal vagy a

• Show Attributes and Methods paranccsal a Frame Objects menüjében.

Megjeleníthető egy objektumot kiválasztva és F3 billentyűt nyomva is.

Emellett tetszőleges számú felhasználói attribútum is megadható. A Plant Simulation

ugyanúgy kezeli ezeket, mint a beépített attribútumokat.
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Azt jelzi, hogy a Plant Simulation tudja-

e mutatni az attribútum értékét vagy 

állapotát (pl. gyakran változó értékeket 

nem)

Objektumok attribútumai

Az attribútum vagy metódus neve

Az attribútum adattípusa, vagy a paraméterek adattípusa

Azt mutatja, hogy az érték örökölt (i) 

vagy nem örökölt (ni)

Value (érték). Csak az attribútumoknak

van értéke.

Duplán kattintva az attribútum nevén megjelenik egy ablak, ahol módosítható az

attribútum értéke.
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Adattípusok és értékeik

148

boolean TRUE vagy FALSE

integer egész érték

real, length, weight, speed, money lebegőpontos szám

string karakterek, számok és speciális 
karakterek

date dátum kifejezés (yyyy/MM/ dd)

time idő kifejezés (hh:mm:ss.ss)

datetime dátum kifejezés, az időt is 
tartalmazva
(yyyy/MM/dd mm:ss)

list, stack, queue egy oszlopos lista

table lista kettő vagy több oszloppal

object referencia szimulációs modellre 
vagy objektumra
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Egyéni attribútumok

Egyéni attribútumok definiálhatók

kiegészítendő az objektumokat olyan

tulajdonságokkal, amelyekre a

modellezés során szükség van. A

szimuláció során a Plant Simulation le

tudja kérdezni, módosítani tudja

ezeket az attribútumokat, akárcsak a

beépített attribútumokat.

Definiálható egyéni attribútum például

színre, méretre, megrendelési számra

stb. Tetszőleges számú egyéni

attribútum definiálható.

Az egyéni attribútumnak megadható a neve (Name), az adattípusa (Data Type), és

az értéke (Value). Az érték hozzárendelhető az egyéni attribútum készítésekor,

vagy módosítható a szimuláció futása alatt is.
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Egyéni attribútumok definiálása

Az egyéni attribútumok a

Custom Attributes fülön

definiálhatók az objektum

ablakában. A listamező

tartalmazza a már definiált

egyéni attribútumokat.

Kattintson a New (Új)

gombra, adja meg az

adattípust, az értéket és

persze az attribútum nevét.
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A TableFile – táblázatos adat

• Ikon:

• Kapacitás: 0

• Információs áram objektum

Jellemzők :

A TableFile egy többoszlopos lista.

A TableFile az igényeknek megfelelően formázható: Megadható az

Oszlopok/sorok száma (Number of columns/rows), az adattípusa (data type) az

oszlopoknak, az értéktartomány, és hozzáadható Oszlop vagy Sor index.
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Tartalom/formátum öröklése

Ezek az opciók a Format (Formátum)

menü:

Inherit Format (Formátum öröklése) vagy

Inherit Contents (Tartalom öröklése)

parancsokkal kapcsolhatók ki.

Az Inherit Contents opció kikapcsolása

után módosítható a tábla tartalma.

Az Inherit Format opció kikapcsolása

után módosítható a tábla formátuma. Ez

az opció kikapcsolja az Inherit Contents

opciót is.

Ezeket a beállításokat kell kikapcsolni mielőtt értékbevitel történik a táblázatba,

vagy módosul az oszlopok adattípusa:
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Oszlop- és sorindex aktivizálása

Show (mutat) vagy Hide (elrejt) az

Column Index (oszlopindex)

és a

Row Index (sorindex)

a menüparancsokkal lehetséges a

Format (Formátum) menüben.

Az oszlop- és sorindexek aktivizálásával beszédes nevek adhatók meg az

oszlopokra és a sorokra, ezzel könnyebben megérthetővé téve a táblázatot. A Plant

Simulation egy vastag vonallal választja el az index sort és oszlopot és a nulladik

sorba, oszlopba helyezi el.
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TableFile beállításai

Oszlop beállításainak módosításához

ki kell választani az oszlopot az

oszlopindex sorban.

A teljes TableFile jellemzőinek

módosításához a Select All (mindent

kijelöl) gombra kell kattintani a

TableFile bal felső sarkában.

Kiválasztás

Format > Format (Formátum)

és meg lehet adni a legfontosabb

jellemzőit a TableFile objektumnak.
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Altáblákat tartalmazó TableFile

Altáblát készíteni a TableFile objektumon

belül a Data type > Table (Adattípus >

táblázat) opcióval lehet a Data type fülön.

A beágyazott táblázatokat a TableFile fülön

lehet formázni, amit a Plant Simulation ekkor

aktivizál.

A beágyazott táblát a TableFile cellára

duplán kattintva lehet megnyitni.
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Adatok importálása és exportálása

A táblázatban lévő adat tárolható szövegfájlban,

ami más alkalmazásokba beolvasható.

A teljes táblázat tárolható objektumként, és másik

szimulációs modellben felhasználható.

Adatok Microsoft Excel formátumban történő

importálása és exportálása támogatott.
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Olyan táblázatok, melyek a Source 
elemgenerálását adják meg

• Adja meg az útvonalát TableFile

objektumnak, ahol a különböző MU 

típusok meg vannak adva, a 

neveikkel és az attribútumaikkal.

• Válassza ki a Format table (táblázat 

formázása) opciót, akkor a Plant 

Simulation automatikusan formázza 

a táblázatot.

A Source objektumban az MU selection > Sequence vagy MU selection >

Sequence cyclical opciót kiválasztva:
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A Source és a kapcsolódó TableFile

Nyissa meg a TableFile objektumot és adja meg

vagy válassza ki a következőket:

MU: Húzza az MU típust az MU mappából a

Class Library -ből az MU cellába.

Number (szám): Egy egész szám megadása.

Name (név): Az MU-hoz itt név rendelhető.

Attribute (attribútum): Az altáblázat nevét kell

megadni, és megnyitni az altáblát kétszer

kattintva, és közben a Shift billentyűt nyomva.

Meg lehet adni a beépített és az egyéni

attribútumok nevét, értékét és adattípusát. Az

altábla neve bármi lehet, az attribútum nevét az

első oszlopban, az értéket a negyedikben kell

megadni.
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• Az alapértelmezett kilépési ág az 1-es sorszámú. Ha az attribútum ezzel a névvel

nem létezik, akkor a Plant Simulation az MU-t az 1-es vagy a szövegmezőben

megadott (Default successor) sorszámú kilépési ágra küldi tovább.

A FlowControl stratégia attribútuma

• Válassza ki az Exit Strategy > Strategy >

Attribute értéket, és a FlowControl objektum az

MU-kat a megadott attribútum értékének

megfelelően továbbítja.

• Ez után ki kell választani az egyéni attribútum

adattípusát az Attribute type listából, és Apply

(Alkalmaz).

• Kattintson az Open List (lista megnyitása)

gombra, és adja meg a keresendő attribútum

nevét, és értékét, valamint a kilépési ág

sorszámát.
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10a lecke

Új MU típus létrehozása az asztallapok számára:

• Container -> Duplicate

• Rename -> TableTop

• Új egyedi jellemző felvétele a TableTop MU - ra,

Quality néven, string típus, good alapérték.

Új MU típus létrehozása az asztallábak

számára:

• Entity Duplicate

• Rename TableLeg
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10a lecke

A festőüzem az asztallapokat különböző színűre

festi. A hibás festésű asztallapokat kiveszi a

gyártásból és megsemmisíti.

A Source (a TestFrame Frame-ben) hozza létre

az asztallapokat jó és rossz festésekkel.

A festőüzem ellenőrzi a minőséget és a megfelelő

állomásra mozgatja tovább az MU-kat.

Figyeljen az öröklődésre: a CompPaintshop

Frame -et csak az osztályban módosítsa, ne a

példányban!

1. Készítsen egy új Frame -et a

FacilityComponents mappában és legyen a

neve: CompPaintshop. Helyezze el az

ábrán látható objektumokat a Frame-ben.
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10a lecke

2. Válassza ki a Strategy > Attribute opciót és a

Data type string opciót a FlowControl

objektumban. Majd kattintson az Apply

gombra, és az Open List gombra.

3. Adja meg a Quality attribútumot a

táblázatban, és az értékét és a kimeneti ág

sorszámát is, ahol az MU mozogni fog.

Az érték kis-nagybetű érzékeny!

4. Nyissa meg az Icon Editor-t a CompPaintshop

Frame-re, rajzoljon egy új ikont és illesszen be

néhány animációs pontot.
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10b lecke

1. Készítsen egy teszt környezetet a TestModel

mappában, legyen a neve: TestPaintshop.

Illessze be a következőket: Source, Drain,

EventController, és a CompPaintshop Frame -et

a Class Library - ből és egy TableFile objektumot.

Kösse össze az anyagáram objektumokat.

2. Nyomja le az F2 billentyűt és nevezze át a

TableFile objektumot productListTable névre.

3. Válassza ki az MU selection > Sequence Cyclical opciót a Source objektumban

és válassza ki ezt a TableFile -t. Válassza ki a Format table opciót. Adja meg a

korábbi értékeket (161. dia)

4. Figyeljen arra, hogy a Plant Simulation különbséget tesz a kisbetűs és

NAGYBETŰS szövegértékek között, amikor a quality attribútum értékét megadja

az legyen: bad és good!

5. Ellenőrizze le a Frame funkcióit.
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További feladatok a 10. leckében
Lista hozzáadása az osztálykönyvtárba

A productListTable objektumot újra fel szeretnénk használni, más leckékben mivel

az tartalmazza a kibocsátási sorrendjét a Source objektumnak, ezért bemásoljuk

ezt a táblázatot a Class Library-be.

1. Válassza ki a TableFile-t és

másolja a Vágólapra a Ctrl+C

billentyűzetkombinációval.

2. Másolja be a táblázatot ahova

kívánja a Class Library

mappájának helyi menüjében

lévő paranccsal.
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10c lecke

1. Készítsen másolatot a Plant_4 objektumból és legyen a neve: Plant_5.

2. Cserélje ki a Paintshop SingleProc objektumot a Paintshop Frame -mel.

3. Illessze be a productListTable objektumot, ami a kibocsátási szekvenciát

tartalmazza, és adja meg ezt a táblázatot, mint a Source sequence cyclical

típusú kibocsátása.
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12. fejezet

Anyagáram objektumok és olyan 

objektumok, amelyek több, mint egy 

elem kapacitásúak
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A Buffer objektum

A Buffer a következő állomásra

mozgatja az MU-kat FIFO stratégiával

(QueueFile) vagy LIFO stratégiával

(StackFile).

Nem lehet a Buffer különálló celláihoz hozzáférni.

A Buffer nagy számú MU fogadására szolgál. A megadott feldolgozási idő azt adja

meg, amíg egy MU kilép a Buffer objektumon.

Jellemzők:

• Ikon:

• Kapacitás: tetszés szerinti, nem 

mátrixos

• Kapacitás orientált anyagáram 

objektum
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A PlaceBuffer objektum

• Ikon:

• Kapacitás: tetszés szerinti

• Helyorientált anyagáram objektum

Jellemzők :

A PlaceBuffer több sorban lévő cellával

rendelkezik. Tetszés szerinti számú MU-t

tud feldolgozni és tárolni.

A feldolgozási időt a teljes PlaceBuffer objektumra lehet megadni, nem külön a

cellákra. Az objektum felosztja a megadott feldolgozási időt a cellák között,

meghatározva azt, hogy milyen módon halad az MU végig az összes cellán. Az MU-k

nem előzhetik meg egymást. A feldolgozási idő lehet nulla perc is.
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A ParallelProc objektum

• Ikon:

• Kapacitás: tetszés szerinti, mátrix alapú

• Helyorientált anyagáram objektum

Jellemzők :

A ParallelProc több cellával

rendelkezik, hogy az MU-kat

párhuzamosan dolgozhassa fel.

A feldolgozási időt bármikor meg lehet

változtatni. Ez nem érinti a

ParallelProc másik celláján lévő MU-

kat. Ennek következtében viszont az

MU-k megelőzhetik egymást.

170



www.graphit.hu

A Store objektum

• Ikon:

• Kapacitás: tetszés szerinti, mátrix 

alapú

• Helyorientált anyagáram objektum

Jellemzők :

Az MU-k a Store objektumon

maradnak, amíg egy metódus

(Method) el nem távolítja azokat. A

Plant Simulation az érkező MU-kat

tetszőleges szabad cellára helyezi el

az objektumon. Ha megtelt (failure),

akkor a Store nem fogad el több MU-t.
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A Line objektum

• Ikon:

• Kapacitás: tetszés szerinti, hossz 

orientált

• Hosszorientált anyagáram objektum

Jellemzők :

A Line egy szállítószalagot reprezentál.

A hossz (length) és a sebesség (speed)

határozza meg azt az időt, amíg az MU

végighalad rajta.

Az MU-k feltorlódását a Line-on az Accumulating opció bekapcsolásával lehet

engedélyezni.

Ez lehetővé teszi az MU-k számára, hogy egymás mögött feltorlódjanak, ha a kilépés

nem lehetséges. Alapértelmezésben a Line kapacitásának nincs határa, ezt a -1 érték

jelöli. Megadható más számérték is, és ekkor a Line nem használja fel a teljes hosszt.
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A Container objektum

• Ikon:

• Kapacitás: tetszés szerinti, mátrix 

alapú

• Helyorientált anyagáram objektum

Jellemzők :

A Container egy MU, amely elemeket

(Entity) szállít és más Container

objektumokat. Ez egy palettát

reprezentál. A Container használható

elemként (Entity) is. A Containeren

lévő Container szállíthat más

elemeket vagy konténereket.

173



www.graphit.hu

• Ikon:

• Kapacitás: 1 fő elem, és szerelvény 

alkatrészek

• Helyorientált anyagáram objektum

Az Assembly Station objektum

Jellemzők :

Az Assembly a szerelvény alkatrészeket

adja hozzá a fő elemhez. A szerelvény

alkatrészeket vagy hozzáadja a fő MU-

hoz, vagy törli azokat az Assembly Table

- ben megadott értéktől függően.

Meg kell adni az Assembly table - ben, hogy mely alkatrészek kapcsolódnak hozzá

a Main MU (fő MU) objektumhoz.

Az Assembly mode listából kiválasztható, hogy a szerelvény alkatrészek (mounting

part) törölve legyenek, vagy a fő MU elemre legyenek mozgatva.
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Az Assembly Station objektum

• Assembly table with (Szerelési tábla): adja meg a Predecessors (bemenő ágak)

vagy MU Types (MU típusok) opciót és a TableFile celláiba írja be a bemenő ágakat

vagy az MU típus neveket.

• Main MU from predecessor (fő MU bemenő ága): a bemenő ágnak a sorszáma

(Tools > Options >Modeling > Show Predecessor).

• Assembly mode (szerelési mód): válassza ki a Delete MUs opciót a szerelés után

a szerelvény alkatrészek törléséhez, az Attach MUs opciót a szerelvény

alkatrészek rárakásához a fő MU - ra.

• Exiting MU (kilépő MU): a Main MU (fő MU) vagy New MU (új MU)

továbbmozgatása a kimenő ágon.
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• Ikon:

• Kapacitás: 1 fő elem szerelvény 

alkatrészekkel együtt

• Hely-orientált anyagáram objektum

A Dismantlestation objektum

Jellemzők :

A DismantleStation objektum eltávolítja

a szerelvény alkatrészeket a fő MU-ról,

vagy újakat készít. Szétszerelési

folyamatok modellezésére szolgál.

Az Attributes fülön lehet megadni, hogy a DismantleStation objektum hogyan hajtja

ezt a feladatot végre.
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11a lecke

Az asztallábak az asztallapokhoz a CompAssembly

Frame-ben adódnak hozzá.

1. Készítsen egy új Frame - et a Facility-

Components mappában CompAssembly

névvel.

2. Illessze be a bal oldali ábrán látható

objektumokat. A feldolgozási ideje a Assembly

objektumnak legyen 10 perc.

3. Az InTableTop Interface beviszi az

asztallapokat az állomásba, az InTableLeg

Interface pedig az asztallábakkal teszi

ugyanezt.

4. Válassza ki a Tools > Options > Show

Predecessor opciót a menüből.
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11a lecke

Először adja meg, hogy melyik

Predecessor - ból kapja az

Assembly állomás a fő MU-kat,

ebben az esetben az

asztallapokat.

Adja meg a predecessor sorszámát, amelyik az asztallábakat adja az

asztallaphoz.

Válassza ki az Assembly mode > Attach MUs opciót, így a fő MU lép ki az

Assembly állomásról.

178
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látható ábrának megfelelően a

beállításokat az Assembly objektumra:
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11b lecke

1. Rendeljen hozzá a CompAssembly Frame-

hez új ikont.

2. Készítsen egy új Frame-et a TestModel

mappában, legyen a neve: TestAssembly.

3. Illessze be a következőket: két Source, Drain,

EventController és az Assembly Frame, majd

kösse össze az objektumokat. Győződjön meg

arról, hogy a Source objektumok a megfelelő

típusú MU-kat hozzák létre.

4. Ellenőrizze az Assembly funkcióit.
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11c lecke

1. Készítsen másolatot a Plant_5 objektumból, és legyen a másolat neve:

Plant_6.

2. A TestAssembly Frame funkcionalitásának tesztelése után helyezze azt be az

Assembly SingleProc helyére.

3. Illessze be a Source objektumot (állítsa be a készítendő MU-k típusát),

amelyik az asztallábakat készíti, és egy Line komponenst a Frame-hez.

Legyen a Line hossza 2 m és sebessége 0,5 m/s.
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Line – A görbe definiálása

A szállítószalag görbeként, nem

csupán objektumként történő

beillesztéséhez a görbe módot kell

aktivizálni.

A Segments (szegmensek) táblázat

mutatja a görbe szegmenseinek

paramétereit.
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Line - attribútumok

A szállítószalag a saját hosszát a

görbék hosszából számítja.

Ha ez nem megfelelő számunkra,

akkor a Curve fülön ki lehet kapcsolni

a számítását.
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13. fejezet

Hibák, meghibásodások
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Meghibásodások

A valós élet szituációinak modellezéséhez, ahol a gépek időnként meghibásodnak,

ami érinti a használhatóságukat, és a rájuk szervezhetőséget, a rendszerben

lehetőség nyílik meghibásodások definiálására is.

Ez a komponens állapotát átállítja az operational (működő) állapotból a failed

(hibás) állapotba. A Plant Simulation hozzáadja a meghibásodás idejét a

feldogozási időhöz és az otttartózkodási időhöz.

Meghibásodás minden anyagáram objektumra megadható.

Az objektumnak a bal felső részénél egy piros LED jelenik meg.

Ha korábbi Plant Simulation verzióban készült modellnél

szeretne az állapotokhoz ikont rendelni, akkor egy új ikont kell

készíteni failed névvel. Valamint válassza ki az

Icon > Use State Icons

pontot az ikonszerkesztőben, hogy az objektum használja az

állapotikonokat a LED - ek helyett.
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Meghibásodás megadása

Meghibásodások 

aktivizálása

Rendelkezésre 

állás megadása

Min alapuljon a 

meghibásodás

A Mean Time Between Failures (meghibásodások közötti idő) (MTBF) és a Mean

Time To Repairs (javítás ideje) (MTTR) használható a meghibásodás idejének

kiszámítására.

Adja meg a rendelkezésre állást százalékban. A Plant Simulation Erlang eloszlást

használ az intervallumra és Weibull eloszlást az időtartamra.

Egy komponenshez tetszőleges számú meghibásodás rendelhető.
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Meghibásodás megadása

A Plant Simulation számos eloszlást nyújt a meghibásodási

intervallum és a meghibásodás időtartamának megadására.

Ki kell választani az eloszlást, és meg kell adni a rá jellemző

paramétereket.

A Plant Simulation a Start idő szövegmező fölött mutatja,

hogy milyen paramétereket kell megadni.
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Véletlenszerű folyamatok - Seed értékek

Válassza ki a

Tools > Seed Values menüpontot a főmenüből, ami megnyitja

a seed values (alapszámok) táblázatot.

A Seed Values táblázat véletlenszerű értékeket

tartalmaz egymás után.

Ezek mindegyike két alapszám értéket igényel,

amelyek egész számok. Ezek az értékek adják meg

a véletlen számok sorát, amelyet a Plant Simulation

generál.

Különböző véletlenszám sorok azonos

alapszámokkal azonos véletlenszám sorokat

generálnak.
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12. lecke

Meghibásodások a Plant_6 Packing modellben

Adja meg az ábrának megfelelő értékeket a szövegmezőkbe a Failures fülön a

Packing SingleProc ablakában. A meghibásodások az Operating Time-ra

(működési időre) hivatkoznak.
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14. fejezet

Az EventDebugger
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Az EventDebugger

Az EventDebugger annak megtekintésére szolgál, ahogy a Plant Simulation

feldolgozza a különálló eseményeket a szimuláció futása során.

A modellben lévő hibák megtalálására használható. A még fel nem dolgozott

eseményeket jeleníti meg listában.

Illesszen be egy breakpoint - ot (töréspontot) az esemény előtt, és hajtsa végre az

eseményt lépésről-lépésre.

Az EventDebugger aktivizálása:

Kattintson az EventController ablakában a List (lista) nyomógombra.

Lehetőségek:

Step (végiglépkedés) az eseményen egyszerre egy lépésen.

Adja meg Breakpoint - okat az események előtt.

Bezárás:

Kattintson a Close gombra.
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Az Eventdebugger
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Időkezelés
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• Ikon:

• Kapacitás: 0

• Erőforrás objektum

A ShiftCalendar objektum

Jellemzők :

A ShiftCalendar az üzemben lévő

különböző műszakok modellezésére

szolgál.

Egy műszakban ki lehet kapcsolni

gépeket a modellben az anyagáram

objektum Pause attribútumának

átállításával igazra (true).
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A ShiftCalendar – Műszak idők

Mielőtt a beállításokat szerkesztené kapcsolja ki az öröklődést és kattintson az

Apply gombra.

Adja meg a műszak (Shift) nevét, a kezdési időt (From), a befejezési időt (To), és a

szünetek hosszát (Pauses) a Shift Times fülön. Annak megadására, hogy melyik

műszak melyik napon dolgozik a következő cellákra kell kattintani: Mo, Tu, We, Th,

Fr, Sa, Su.

A műszakok között lehet átfedés. Amíg egyetlen műszak sem dolgozik, a

kapcsolódó objektumok sem működnek. A Plant Simulation a statisztikában ezt

UnplannedTime néven jegyzi be.
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A ShiftCalendar - Ünnepnapok

Meg lehet adni azokat a napokat, amikor a gyár nem dolgozik (Date From és Date

To) vagy csak részidőben dolgozik (Reduced Time). Megjegyzés (Comment)

fűzhető a Calender fülön, ami leírja a napot. Például 2010. január 2. megadható

02.01.2010 vagy 2010/01/02 formátumban is.

Ha a gyár egész nap nem dolgozik, akkor a Reduced Time oszlopba nem kell

beírni semmit.
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ShiftCalendar importálása

Az ünnepeket és egyéb napokat tartalmazó fájlok tab-

elválasztott szövegfájlként importálhatók:

Kattintson a Calendar fül hátterén és válassza ki az

Import opciót.
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ShiftCalendar aktivizálása

Bármely anyagáram objektumot húzd és ejtsd módszerrel rá kell ejteni a

ShiftCalendar objektum ikonjára, vagy meg kell adni a használni kívánt

ShiftCalendar objektum nevét a Controls fülén az anyagáram objektum ablakában.
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13a lecke

Leállások vezérlése ShiftCalendar segítségével

1. Készítsen egy CompPacking Frame-et a

FacilityComponents mappában.

2. Illessze be a képnek megfelelő

objektumokat, a Buffer Kapacitása

(Capacity) legyen 100.

3. Húzza rá a Packing SingleProc ikonját a

ShiftCalendar objektumra.

4. Adja meg a műszakidőket, és a csökkentett munkaidejű napokat a

ShiftCalendar objektumban, kapcsolja ki az öröklődést. Ezek az értékek a

következő fólián lesznek. Adja meg az EventController kezdő időpontját.
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13a lecke

Szünetek 9:00-9:15

(munkanapokon) 12:00-12:45

18:00-18:30

20:30-21:00

Műszakidők és nem munkanapok megadása.
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13b lecke

1. Készítsen egy tesztkörnyezetet a

TestModel mappában. Tesztelje a

Packing Frame-et. Ellenőrizze a Packing

állomás megállásait.
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13c lecke

Készítsen másolatot a Plant_6 objektumból, legyen a másolat

neve Plant_7, és illessze be a CompPacking Frame-et a Packing

SingleProc helyére.
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16. fejezet

Statisztikák megjelenítése a 

TimeSequence segítségével
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A feladat

Szeretnénk statisztikát látni arról, amikor az

összeszerelt asztalok megérkeznek a szállításra

(Shipping).

206

A TimeSequence objektumot

használjuk az időpillanatok és az

asztalok darabszámának rögzítésére a

Shipping osztályon.

Ehhez a Drain statNumIn attribútumát

fogjuk használni.
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A TimeSequence objektum

• Ikon:

• Kapacitás: 0

• Információs áram objektum

Jellemzők :

A TimeSequence a szimuláció futása során

értékeket rögzít, mint például az áramló

elemek számát, stb.

Ki kell választani a megfelelő adattípust a

rögzített attribútumhoz a Value oszlopban!

Győződjön meg arról, hogy a Resource statistics opció aktív arra az

objektumra, melynek az adatait gyűjteni kívánja.
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A TimeSequence - Start Values fül

Válassza ki a Time Reference – t a Start

Values fülön:

Absolute: Időpont.

Relative: Időtartam.

A legtöbb esetben a relatív időreferencia

használható nulla értékkel, ami azt jelenti,

hogy a TimeSequence azonnal elkezdi az

aktív értékek rögzítését.
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A TimeSequence – Recording fül

Meg kell adni a rögzítendő érték útvonalát a

Recording fülön.

Ki kell választani a figyelés módját (Mode) :

Watch: Amikor az érték változik.

Sample: Periódikusan, akár változott, akár

nem.

Az Active opciót be kell kapcsolni, hogy

rögzítse is az értékeket!
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14. lecke

Statisztika gyűjtése a TimeSequence használatával

1. Készítsen egy CompShipping Frame - et

a FacilityComponents mappában.

2. Illessze be az ábrán látható objektumokat.

A TimeSequence a Drain objektumba

érkező MU-k számát kell, hogy rögzítse. A

statisztika a TimeSequence Contents

fülén jelenik meg.

3. Illesszen be a reset metódust. Ez a metódus törli a TimeSequence által

rögzített értékeket minden szimulációfutás után.

4. Mit kell kiválasztani, hogy a Drain statisztikáját gyűjtsük?

5. Készítsen másolatot a Plant_7-ből Plant_8 néven. Illessze be a Shipping

Frame-et.
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17. fejezet

CAD modell betöltése háttérként
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Miért hasznos a CAD kép, mint háttér?

• Áttekinthetőbbé teszi az elrendezést

• A szállítószalagok és az utak használhatják annak arányait

• Pontos pozícionálást tesz lehetővé
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CAD fájl használata

Húzza és ejtse a CAD fájlt a

megfelelő Frame-re.

Megjelenik egy üzenetablak,

amely megkérdezi, hogy valóban

háttérként kívánja-e használni a

fájlt.

Nem válasz esetén egy újabb

üzenet jelenik meg, rákérdezve

arra, hogy beágyazni kívánja-e a

fájlt a Frame-be.
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CAD fájl skálázása

A skálázási tényező a hosszmérték egy képpontnak megfelelő hossza.

Alapértelmezetten két rácspont között (20 pixel) a távolság 1 méter.
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15. lecke

A „TableAssembly.dwg“ modell egy pixel milliméterenként. Így a skálázási 

tényező az importáláskor 50.

• Készítsen másolatot a

Plant_8 modellből, legyen

a neve Plant_8_with_CAD

• Adja meg a skálázási

tényezőt (Scaling factor)

• Importálja a layout - ot

• Állítsa alapértékre a

skálázási tényezőt

• Rendezze át az

objektumokat az

elrendezésnek megfelelően
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Visszatekintés
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Tanfolyam

Plant Simulation 9

2. modul: Stratégiák
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1. fejezet

A feladat
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Gyár elrendezés

CutToSize

Méretrevágás

Milling1

Marás 1

Paintshop

Festőüzem

Quality

control

Minőség-

ellenőrzés

Packing

Csomagolás

Receiving

Table-Legs

Asztallábak érkezése

Milling2

Marás 2

Shipping

Szállítás

Buffer

Tároló

Assembly

Szerelés
Conveyor - Szállítószalag

Rejects

Selejt

Store

Table-Tops

Asztallapok tárolása
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Gyár elrendezés

Az asztalgyártó üzem
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Komponensek

Milling 

Marás
Paintshop 

Festés

Assembly

Szerelés

Packing 

Csomagolás

Shipping 

Kiszállítás
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2. fejezet

A Metódus (Method) 

objektum, használatának módja és 

beállításai
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Objektum-orientált programozás

... Az objektum-orientált nyelvek objektumokon alapulnak, amelyek

adatszerkezeteket tartalmaznak, és műveleteket (metódusokat). Az

objektumban tárolt információ csak az objektumosztály metódusain

keresztül manipulálhatók. Az objektum egy metódusának elindításához

egy üzenetet kell küldeni az objektumnak, ami tartalmazza a metódus

nevét és paramétereit. A működés futás közben az üzeneteken alapul.

...*

* Dubbel Taschenbuch für den Maschinenbau, 18. Edition
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Mi is az a metódus (Method)?

A metódus (Method) egy kis program, hasonló a Basic, Pascal vagy C++ nyelvek

függvényeihez.

A SimTalk, a Plant Simulation programozási nyelve az Eiffel programozási nyelven

alapszik. Ez erősen hasonlít más programozási nyelvekre.

Készíthető olyan metódus, amely képes a modellbe illesztett objektumok

attribútumainak olvasására, és módosítására. Egy objektumot kiválasztva és az

Objects > Show Attributes and Methods parancsot használva az összes

beépített attribútum és metódus megjeleníthető.

Emellett tetszőleges számú felhasználói attribútum is definiálható.

A Method objektum teljesen integrált a Plant Simulation objektum-orientált

koncepciójába. A forráskód közvetlenül a Method objektumba illeszthető be. Ez

után a rendszerbe beépített fordító (Interpreter) feldolgozza a programkódot a

szimuláció futása során.
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Mit tud egy metódus tenni?

Egy metódus alkalmas a következőkre:

• A szimuláció során történő eseményekre történő reagálásra.

• Különböző jellemzők lekérdezése és beállítása.

• Kifejezések futtatása.

• Objektumok módosítása és viselkedésük kiterjesztése.

• Új felhasználók számára egyéni párbeszédablakok készítése a modellhez.

Ez lehetővé teszi:

• Különböző megközelítések implementálását, a modell teljeskörűen

igényekre szabását.

• A szimulációs modell hatékonyságának növelését.

• A szimulációs modell rugalmasságának növelését.
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Method (metódus) objektum

A metódus 

teste

Jellemzők :

• Ikon:

• Kapacitás: 0

• Információ áram objektum

A modellbe beillesztve egy metódust, a Plant Simulation kikapcsolja az Inherit

Source Code (forráskód öröklése) opciót (az osztálytól).
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A metódus eszköztára

Find

Keresés

Bookmarks

Könyvjelzők

Run (F5)

Futtatás

Debug (F11)

Hibakeresés

Inherit Source 

Code / 

Forráskód 

öröklése

Apply 

Changes (F7)

Változtatások 

alkalmazása

Undo / Redo

Visszavonás / Ismétlés
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Options-Editor
(beállítások-szerkesztő)

Válassza ki a következő

menüpontot:

Tools > Preferences (Eszközök >

Beállítások)

Meg lehet adni a metódus

szerkesztő beállításait.

Javasolt bekapcsolni a

Display line numbers

(Sorszámozás mutatása)

opciót.
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Options—Simulation
(beállítások-szimuláció)

Azt adja meg, hogy hány metódus

hívható meg másik metódusból.

Az egyszerre meghívható metódusok

maximális száma.

Az egy időben nem futó metódusok

maximális száma, amelyek esemény

történésére várnak.
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3. fejezet

Metódusok szintaxisa

A SimTalk programozási nyelv

Metódus hibakeresés
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Egy metódus szerkezete

 a funkcionalitás argumentumok (paraméterek) hozzáadásával bővíthető. A

meghívónak annyi paramétert kell átadnia, amennyi a metódusban definiált.

Az átadott adattípusnak meg kell egyezni a várt adattípussal.

 meg kell adni a visszatérési érték típusát. Ezt a meghívóhoz a result

kulcsszóval kell kapcsolni, amikor visszatér az értékkel.

 elválasztja az argumentumok és a helyi változók deklarálását

 a helyi változókhoz csak abban a metódusban lehet hozzáférni, amelyben

azok deklarálva lettek. Akkor kell használni ezeket, ha csak az adott

metóduson belül van szükség az értékükre.

 a megfelelő forráskód a do után következik.

 a forráskód, a kifejezések, ciklusok, metódus hívások, stb.

 a forráskód végét jelzi. Az end után már csak megjegyzések következhetnek.

[Argument]

[Result]

is

[Local variables]

do

[Statements] 

end;

Egy Method (metódus) objektum a következő részekből áll, nem mind kötelező. 
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(

Egy metódus szintaxisa

forráskód;do

is

adattípus:argumentum:

;

,

) :
visszatérési 

érték

adattípus:változó ;

:

end;
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SimTalk műveletek

- Hozzárendelés művelet

A hozzárendelés művelet := új értéket rendel egy változóhoz. <változó> := <új

érték>;

- Számtani műveletek

Összeadás, kivonás, szorzás, osztás (+, –, *, /) és egyéb műveletek, mint például

a trigonometriai funkciók, logaritmus és exponenciális funkciók.

- Összehasonlító műveletek

Összehasonlító műveletek =, /=, >, >=, <, <=, = = két értéket hasonlítanak össze.

Az eredmény TRUE (igaz) vagy FALSE (hamis) boolean adattípussal.

Az and (és), or (vagy), not (nem) boolean műveletek is használhatók

kifejezésekre.

- Bemeneti és kimeneti műveletek

Adat betöltés és mentésre szolgálnak.
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Metódus sablonok

A metódus sablonok használata nagyon egyszerű és

biztonságos módja a programozásnak, mivel egy komplett

kódrészletet illeszt be.

A metódus sablonok definíciója lehetővé teszi előre

definiált metódusok használatát.
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Megjegyzések

A megjegyzések megnövelik a metódus olvashatóságát, és segítenek megérteni

annak funkcióját.

Az is beírható, hogy melyik objektum hívja meg a metódust.

Két kötőjellel – – kezdődik az egy

soros megjegyzés, ami a sor

végén véget is ér.

Több soros megjegyzés /* kezdet

és */ vég közé írható be.

A Method (metódus) a megjegyzés szövegét zöld színnel jeleníti meg.
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Példa kód

A példa egy egyszerű kifejezést, helyi változót, és bemeneti és visszatérési

paramétert mutat be:

Helyi változó (Local variable)

Bemeneti argumentum

(Input argument)

Visszatérési argumentum

(Return argument)

Forráskód (Statement)

A metódus meghívja az M2

metódust, és átadja az

argumentumokat.

A result kulcsszóhoz történő

hozzárendelés szükséges ahhoz, hogy

az érték visszaadódjon a meghívó

metódusnak.
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Hibakeresés metódusban - Method 
Debugger

A Plant Simulation automatikusan megnyitja a Hibakeresőt (Debugger), amikor a

forráskód olyan hibát tartalmaz, ami miatt a kód nem futhat le. A hibák meg

találására is lehet használni, és megvizsgálható vele ahogyan a megírt

programrészek futnak.
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A Debugger megnyitása:

• Adja meg a töréspontokat (F9).

• Válassza ki a menüből a Debugger > Open Debugger parancsot vagy nyomja

le az F8 billentyűt vagy tartsa lenyomva a Shift+Alt+Ctrl billentyűket, amikor a

metódus elkezd futni.

Használható továbbá:

• Helyi változók, argumentumok és a hívó objektumról szóló információk

megtekintésére, és az MU műveletek megjelenítésére a Watch Window

ablakban.

• Metódus futásának végigkövetése lépésről lépésre.

• Hibák felfedezése azokból a hibaüzenetekből, amelyeket a hibakereső

megjelenít.

Hibakeresés metódusban - Method 
Debugger
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Breakpoints (töréspontok) –Metódus 
futtatása lépésről lépésre

A töréspontok a metóduson belül segítenek a működésének áttekintésében, vagy

lépésről lépésre futtatásában.

Nyissa meg a metódus ablakát, mozgassa a kurzort abba a sorba, ahova

töréspontot kíván elhelyezni, és nyomja le az F9 billentyűt.

Amikor a forráskód futáskor ehhez a sorhoz ér, a Plant Simulation megnyitja a

Debugger ablakot és kiválasztja a töréspontot.

Kattintson az eszköztáron lévő gombokra a program futásának folytatásához, vagy

megszakításához.

Terminate 

Simulation 

(Szimuláció 

megszakítása, ha 

hiba történik)

Forráskód

futtatása

lépésről lépésre
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A hibakereső eszköztár

Switch to Executed 

Method / 

Átkapcsolás 

futtatásra

Watch Window

Figyelő ablak

Step Over 

(F10)

Átlépés

Step In (F11)

Belelépés

Step Out (Ctrl+F11)

Kilépés

Continue (F5)

Folytatás

Terminate Simulation

Szimuláció megszakítása

Insert or Remove 

Breakpoint

Töréspont 

beszúrása/eltávolítása

Remove All Breakpoints

Minden töréspont eltávolítása

Find

Keresés
Show Line 

Numbers

Sorok 

számozásának 

mutatása
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Metódus a hibakereső ablakában

Breakpoint

Töréspont

Az argumentumok és a helyi változók értékei megjelennek a Watch Window-ban.

A Watch Window mutatja, hogy az

MU amely meghívja a Method (@)

- ot, és a nevét az objektumnak,

amely meghívja a Method (?) - ot.
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1. lecke – Metódus definiálása

1. Adja hozzá a MethodAddition Frame-et az

Exercises mappához. Illesszen be két

Method objektumot.

2. Írja be az ábrán látható kódot. Kapcsolja ki az

öröklődést.

3. Győződjön meg, hogy a Console (Konzol)

megjelenik (View > Viewers > Console).

4. Indítsa el az M1 metódust a menü

parancsokkal vagy ezekkel a gombokkal:

5. Futtassa a metódust lépésről lépésre, nyissa meg a Watch Window

ablakát és figyelje meg az értékeket.

6. Adjon meg egy töréspontot és futtassa a metódust ismét.
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1b lecke – Metódus definiálása

• Készítsen és teszteljen olyan metódust, amely egy szám

négyzetét számítja ki
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4. fejezet

Nevek, azonosítók és útvonalak
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Nevek, azonosítók, útvonalak

Útvonalak

Minden objektumnak egyedi címe van. Néha hasznos tudni ezt a címet, hogy

egyedileg azonosíthassuk az objektumot.

Különbség van azonos hierarchia szinten lévő, de azonos illetve különböző

névtérben lévő objektumok között.

A relatív útvonal azonos névtérben lévő objektumot hív meg. Az abszolút útvonal

pedig másik hierarchia szinten lévő objektumot hív meg.

Emellett használhatók névtelen azonosítók, általános azonosítóval rendelkező

objektumok meghívására.
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Névtér

Névtér

Névtér

Névtér

Névtér

Minden objektum a hierarchia azonos szintjén azonos névtérben található. A névtéren

belül minden objektumnak egyedi nevének kell lennie. Különböző névtérben lévő

objektumoknak lehet azonos a nevük.
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Példa abszolút útvonalra

Névtér

Névtér

Névtér

Névtér

.Models.Plant_4.CompMilling.Milling2
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Az abszolút útvonal

• A pontos helyét adja meg a objektumnak tekintet nélkül a Frame-ben lévő

hierarchiai szintjére.

• Más hierarchia szinten lévő objektumok hívása esetén szükséges.

• Mindig a Class Library-vel kezdődik, és végighalad a mappákon és Frame-eken

az objektumig.

• Mindig ponttal kezdődik, majd utána név, majd pont, majd név, majd pont

egészen addig, amíg az objektum nevét eléri:

.<név>.<név>.<név> ....

• A hívott objektum nevét tartalmazza az utolsó pozícióban.

• A feldolgozásához idő kell.
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Példa relatív útvonalra

Névtér

Névtér

Névtér

Névtér

CompMilling.Milling2

249



www.graphit.hu

A relatív útvonal

• Objektumot hív meg azonos névtérből, anélkül, hogy másik hierarchia szintre

lépne.

• Soha nem kezdődik ponttal.

• Rövidebb a feldolgozási ideje, mint az abszolút útvonalnak.

• Lehetővé teszi metódusok és objektumok rugalmas és általánosan használható

elkészítését.

• Frissül, ha változik a modell struktúrája.
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Névtelen azonosítók

Ha egy útvonalat egy objektumhoz a lehető leguniverzálisabbá akar tenni, és a 

lehető legrugalmasabbá, akkor lehet szükség a névtelen azonosítókra.

Erre a célra számos névtelen azonosító használható.

Amellett, hogy univerzálisak, pontosan azonosítanak egy adott objektumot. 
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Annak az MU-nak a meghívása, amely 
kiváltotta a metódust - @

A névtelen azonosító @ egyedileg azonosítja

azt az MU-t, például table_top:6712, amely a

metódust kiváltotta, amikor belépett az

objektumba vagy kilépett az objektumból.

A Plant Simulation akkor is egyedileg jelöli az

MU-kat, ha több objektum metódusai hívódnak

meg. Az MU másik objektumon is lehet.

@
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Az aktív metódus meghívása - self

self

A self névtelen azonosító az éppen futó metódus útvonalával tér vissza:

self; visszaadja a metódus nevét és útvonalát

(.Exercises.Frame.M1)

self.Name; visszaadja a metódus nevét (M1)
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Objektum vagy metódus meghívója -
?

?

A ? névtelen azonosító azt az anyagáram objektumot vagy metódust jelenti, amely

a metódust meghívta. A ? alkalmazásával lehetőség nyílik olyan metódusok

készítésére, amelyek módosítás nélkül használhatók több objektummal is.
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Az aktív Frame meghívása - current

current

A current (jelenlegi) névtelen azonosító azzal a Frame - mel tér vissza, amelyen a

metódus objektum található. Ezzel a módszerrel könnyen kinyerhető a metódus

Frame - je, és átadható argumentumként más Frame - ek számára.
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Az aktív Frame helyének meghívása -
location

location vagy ~

A location vagy ~ metódus azzal az objektummal tér vissza, amelyik közvetlenül a

<path> által kijelölt objektum fölött van. Az MU – ra ez az az objektum, amelyen

található.

<object>.location azzal a Frame útvonallal tér vissza, amelyen az objektum

található.

@. location  az MU esetében a 

location az az objektum, amelyen az 

MU található.
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A hierarchia legfelsőbb szintjének 
meghívása - root

root

A root (gyökér) névtelen azonosító a Frame hierarchiában a legfelső Frame.

Innen lefelé lehet haladni a modell felé. Ez az azonosító különösen hasznos, a

legfelső, gyökér Frame neve nem ismert.
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2. lecke – Névtelen azonosítók

1. Adja hozzá a FrameOutside Frame - et az Exercises mappához.

2. Adja hozzá a FrameInside Frame - et ugyanahhoz a mappához.

3. Illesszen be egy Method objektumot a FrameInside Frame - be és írja be az

ábrán látható programkódot.

258



www.graphit.hu

2. lecke – Névtelen azonosítók

4. Nyissa meg a FrameOutside Frame - et, és húzza bele a FrameInside Frame

- et.

5. Figyelje meg a névtelen azonosítók értékeit a konzolon (Console).

6. Nyissa meg a metódust a FrameInside Frame - ben, futtassa lépésről-lépésre

és figyelje meg amit a konzol megjelenít. Az értékek használhatók lokális

változókban, és megjeleníthetők a Watch Window ablakában a

hibakeresőnek.

A metódusok egymásba ágyazása megmutatja a névtelen azonosítók

használatát különböző hierarchia szinteken.
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2. lecke – Megoldás

Console

Konzol
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5. fejezet

Metódus hívások időzítése
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Azok a modellesemények, amelyek 
metódusokat hívnak meg

1. Az alábbi gombokra kattintva az EventController objektumban a következő

metódusokat hívja meg:

Reset: meghívja a reset metódust a megnyitott modellben.

Init: meghívja az init metódust a model resetelése után.

2. A Plant Simulation a modell fájl megnyitásakor lefuttatja az autoexec metódust,

aminek az osztálykönyvtárában kell lennie.

3. A Plant Simulation a szimuláció futásának végén az endSim metódust hívja meg.

A szimuláció akkor ér véget, amikor az EventController feldolgozta az

eseményeket a List of Scheduled Events listából, vagy amikor a Plant

Simulation eléri azt az időpontot, ami az End mezőben meg lett adva a Settings

fülön.

4. A Trigger és a Generator objektumok szintén meg tudnak hívni metódust.

Egy esemény, ami egy adott pillanatban történik a modellben meghívhat metódust:
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A reset metódus

Az EventController Reset gombjára kattintva a Plant Simulation végigkeresi a

teljes modellt, beleértve az összes Frame-et, reset nevű metódusokért és

lefuttatja azokat.

A Reset metódus használható változók, számlálók értékeinek alapértékre

állítására.
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Az init metódus

Az EventController Init gombjára kattintva a Plant Simulation lefuttatja az összes

init nevű metódust a modellben. Az init metódusok a modell inicializálására

szolgálnak, például változók beállítása, MU-k elhelyezése az anyagáram

objektumokon stb.

Illesszen be egy metódust a modellbe, nevezze át (Rename), és a metódus

neveként adja meg az init nevet.
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6. fejezet

Anyagáram objektumok által meghívott 

metódusok
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Belépés és kilépés kontrollálása

Minden anyagáram objektumra meg lehet adni

egy Entrance (belépési) és/vagy egy Exit

(kilépési) kontrollt. Ez hasonló a fotocellához, ami

az anyagáram objektum elejénél és végénél van

elhelyezve.

Minden ilyen fotocellához hozzárendelhető egy

metódus, amit a Plant Simulation lefuttat, amikor

az MU belép az objektumba, vagy kilép az

objektumból.

Különbséget lehet tenni a helyorientált és a

hosszorientált objektumok között.

Entrance control Exit control
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Belépés és kilépés kontrollálása

Adja meg a metódus nevét a

szövegmezőben, vagy kattintson a

hárompontos gombra, és a Select

Object párbeszédablakban

válassza ki a metódust.
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Helyorientált objektumok belépési 
kontrollja

Aktiválásra kerül, amikor az MU belép az objektumba, az MU végig nyilván van

tartva az objektumban, függetlenül annak hosszától.

Miután meg lett adva nem lehet változtatni azt az időt, amit az MU az

objektumon tölt, kivéve, ha a feldolgozási idő képlettel van megadva.
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Helyorientált objektumok elöl aktivált 
kilépési kontrollja

Akkor hívódik meg, amikor az MU kilépni szándékozik az objektumból. Az MU

még az objektumon tartózkodik.

Az elől aktivált kilépési kontroll felülírja az alapértelmezett kilépési

stratégiáját a Plant Simulation - nek. Ezért az MU továbbmozgatását meg

kell oldani.

A kilépési kontroll többször aktivizálható: ha az MU nem tud kilépni az

objektumból, például mert a kimeneti ág tele van, a Plant Simulation addig

hívja meg a kilépési kontrollt, amíg a successor szabaddá válik.
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Helyorientált objektumok hátul aktivált 
kilépési kontrollja

A hátul aktivált kilépési kontroll egyszer hívódik csak meg.

Nem írja felül az alapértelmezett kilépési stratégiát.

Akkor hívódik meg, amikor az MU elhagyja az objektumot, az MU a successor - on

található.
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Hosszorientált objektumok elöl aktivált 
belépési kontrollja

Akkor hívódik meg, amikor az MU be akar lépni az objektumra. Az MU eleje már az

objektumon van, amikor a metódus meghívódik.

Miután meg lett adva nem lehet változtatni azt az időt, amit az MU az

objektumon tölt, kivéve, ha a feldolgozási idő képlettel van megadva.
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Hosszorientált objektumok hátul aktivált 
belépési kontrollja

Akkor hívódik meg, amikor az MU teljes hossza az objektumon található.

Az MU objektumra érésének pillanata, és annak a pillanatnak a

különbsége, amikor a hátul aktivált belépési kontroll aktiválódik a

különbsége, az az idő, ami ahhoz szükséges, hogy az MU teljesen az

objektumra mozogjon.
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Hosszorientált objektumok elöl aktivált 
kilépési kontrollja

Akkor aktivizálódik, amikor az MU el szándékozik hagyni az objektumot. Az MU

még teljesen az objektumon található.

Az elől aktivált kilépési kontroll felülírja az alapértelmezett kilépési

stratégiáját a Plant Simulation - nek. Ezért az MU továbbmozgatását

meg kell oldani.

A kilépési kontroll többször aktivizálható: ha az MU nem tud kilépni az

objektumból, például mert a kimeneti ág tele van, a Plant Simulation addig

hívja meg a kilépési kontrollt, amíg a successor szabaddá válik.
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Hosszorientált objektumok hátul aktivált 
kilépési kontrollja

Akkor hívódik meg, amikor az MU elhagyja az objektumot. Az MU a kilépési

objektumon található.

A hátul aktivált kilépési kontroll egyszer hívódik csak meg.

Nem írja felül az alapértelmezett kilépési stratégiát.
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Hátrafelé belépési és kilépési kontrollok

Hátulról történő belépés kontrollja Hátulról történő kilépés kontrollja

az MU mozgásának iránya

Az MU nem változtatja meg a helyzetét, pl. nem fordul el maga körül, és nem

mozog az elejével a szimuláció mozgásával ellentétes irányba.

Elöl kontrollált

Hátul kontrollált

a szimuláció mozgásának iránya
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Hosszorientált objektumok szenzorai

A hosszorientált objektumokhoz

szenzorokat lehet a hosszuk

mentén tetszőleges helyen

definiálni.

Kattintson a Sensors gombra a

szenzorok listájának megnyitásához.

Kattinson a New gombra a Sensor

párbeszédablak megjelenítéséhez.

Adja meg a beállításokat az

ablakban.
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MU mozgatása a következő objektumra

A move metódus mozgatja az MU-t az egyik objektumról a másikra. A Plant

Simulation a teljes MU-t a hely orientált objektumra mozgatja. A Plant Simulation

az MU-t a hossz-orientált objektumra a megadott sebességgel mozgatja.

SP2-re mozgatás:

@.move;

@.move(SP2);

@.move(1);

SP3-ra mozgatás:

@.move(SP3);

@.move(2);

SP2-re mozgatás:

@.move(SP2);

@.move(1);
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MU mozgatása a következő objektumra

insert

Az insert metódus a teljes MU-t átmozgatja a célobjektumra. A célobjektumnak

elég hellyel kell rendelkeznie az MU számára.

Példa: @.insert(track,3.3);

transfer

A transfer metódus az MU-t a következő anyagáram objektumra mozgatja. Ez a

metódus teljesen eltávolítja az MU-t a jelenlegi objektumról, akkor is, ha a

successor nem rendelkezik elég hellyel.

Példa: @.transfer(track,3.3);

A move, insert, transfer metódusok visszatérése true, ha az MU átmozgatódott,

false, ha nem.
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Predecessor és Successor

Metódusok használata:

succ(<integer>)

pred(<integer>)

objektumok predecessor - ának és/vagy successor - ának tesztelésére. Ez hasznos

kilépési stratégiák modellezésekor.

A meghívott objektum útvonalával kezdve a hivatkozást, a metódus annak

successor - ához vagy predecessor - ához fér hozzá, visszaadva a hozzá

kapcsolódó objektumot. A szám a Connector sorszáma.

@.move(?.succ(1).succ(1));

if Milling.pred(1).name = "CutToSize" then

...

Példa:

@.move(Milling.pred(1));
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3a. lecke: SingleProc be- és kilépési 
kontrollok

1. Adja hozzá a Frame4 Frame - et az Exercises mappához. Adjon meg 5 percet

az MU-k készítési időközeként.

2. Írja be a print self.name kódot a metódusokba, és válassza ki az objektumok

kontrolljait. Ne feledje el, hogyan működik az elől aktivizált kilépési kontroll.

Figyelje meg a metódus hívásakor:

SP1_out: elöl aktivizált kilépési kontroll

SP1

SP2_in: belépési kontroll SP2

SP2_ out: hátul aktivizált kilépési kontroll

SP2

SP3_in: belépési kontroll SP3

Illessze be a az ábrán látható metódusokat, és figyelje meg az eredményt a konzol 

ablakban:
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3b. lecke:
Line be- és kilépési kontrollok

SP1_out: elöl aktivizált kilépési kontroll SP1

SP2_in: hátul aktivizált belépési kontroll SP2

SP2_out: hátul aktivizált kilépési kontroll SP2

SP3_in: elöl aktivizált belépési kontroll SP3

1. Másolja át a Frame4 Frame tartalmát és másolja be azt a Frame5 Frame-be.

2. Cserélje ki a SingleProc objektumokat Lines objektumokkal és adja meg a

metódusokat a lentieknek megfelelően.

3. Indítsa el a szimulációt és figyelje meg, hogy mit mutat a konzol ablak.

Figyelje meg, hogyan viselkednek a belépési és kilépési kontrollok a hosszorientált

objektumokra.
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7. fejezet

Kifejezések
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Attribútumok és metódusok mutatása

Válassza ki a Class Library helyi menüjéből a Show Attributes and Methods parancsot

az osztály attribútumainak/metódusainak megjelenítéséhez.

A kiválasztott példány attribútumait/metódusait a Frame menüjének Objects > Show

Attributes and Methods parancsával lehet megjeleníteni.

Az attribútum vagy metódus neve Az attribútum adattípusa, vagy a paraméterek adattípusa

Azt mutatja, hogy az érték örökölt (i)

vagy nem örökölt (ni)

Azt jelzi, hogy a Plant Simulation tudja-e

mutatni az attribútum értékét vagy állapotát

(pl. gyakran változó értékeket nem)

Value (érték). Csak az attribútumoknak

van értéke. Dupla kattintás

szerkesztéshez.
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Érték hozzárendelés

Értéket az értékadás művelet (:=) jobb oldalára megadott értékkel lehet adni.

<kifejezés> := <érték>;

Példa:

buffer.capacity := 8;

singleProc.Pause := true;

@.curricon := "TableTop";

Ha szövegnek ad értéket, akkor idézőjelek közé kell tenni az adott szöveget.
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Automatikus kiegészítés használata

Az automatikus kiegészítés a forráskód gépelése során használható: be kell gépelni

az első vagy első két karakterét az objektumnak, attribútumnak vagy metódusnak,

és az Edit > Auto Complete menüpontot kiválasztva vagy a Ctrl + Space

billentyűket lenyomva működik az automatikus kiegészítés.

A Plant Simulation kiegészíti a szót. Ha szükséges hozzáadja a megfelelő

karaktereket (pont, vessző, bezáró zárójel, értékadás művelet, stb.).

Ha a név nem egyedi, a Plant

Simulation egy listát nyit, ahonnan

kiválasztható egy elem. A le-fel

nyilakkal lehet lépkedni, az Enter

billentyűvel pedig kiválasztani a

kívánt kifejezést.
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4. lecke: Objektum attribútumának 
módosítása metódussal

1. Adja hozzá a ChangeAttributes Frame - et az Exercises

mappához.

2. Illesszen be egy ParallelProc és egy Method objektumot.

3. Módosítsa a Method segítségével a ParallelProc megfelelő

attribútumait:

• Processing time: 120 sec (feldolgozási idő 120 másodperc)

• X-Dimension: 5, Y-Dimension: 3 (x irányú méret: 5, y irányú méret: 3)

• Zárolja a ParallelProc belépését (Entrance locked)

• Ellenőrizze le a Show Attributes and Methods ablakban, hogy az értékek a

megfelelő módon megváltoztak.
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8. fejezet

Feltételes kifejezések - if, inspect
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Elágazásos if

Az if kifejezést akkor érdemes használni, ha a metódus további futása egy feltétel

eredményétől függ.

Ha a feltétel eredménye true (igaz), akkor a metódus az első utasításcsoporttal

folytatja a futást, ha a feltétel eredménye false (hamis), akkor a metódus a második

utasításcsoporttal folytatja a futást.

Ha nem szükséges, a második utasításcsoport elhagyható.

feltétel
első uta-

sításcsoport;
második uta-

sításcsoport;then else end;if
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Példa if utasításra
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Elágazásos If Elseif

Az if then elseif kifejezés használatával a metódus különböző feltételekre tud

reagálni. A Plant Simulation kiértékeli a feltételeket – egyiket a másik után – addig,

amíg az egyik visszatérése true (igaz) lesz. Ez után lefuttatja a feltételhez tartozó

utasításokat. Ha nincs igaz ág, akkor az opcionális else ág fut le. Ha else ág nincs,

akkor a Plant Simulation folytatja a kódot a lezáró end kifejezés után.

if utasítások 1;feltétel 1

end;

then

elseif feltétel n then utasítások n;

else utasítások m;
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Példa If Elseif kifejezésre
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Az Inspect kifejezés

inspect kifejezés_1

end;

when érték_n then utasítások_n;

else utasítások;

,

Az inspect kifejezés lehetővé teszi több választási lehetőség közüli választás

egyszerűbb leírását. Így nem kell hosszú if-then-elseif utasításláncokat írni.
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Példa Inspect kifejezésre
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9. fejezet

Táblázatok és globális változók
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Táblázatok és globális változók a 
festőüzemben

CutToSize

Méretrevágás

Milling1

Marás 1

Paintshop

Festőüzem

Quality

control

Minőség-

ellenőrzés

Packing

Csomagolás

Receiving

Table-Legs

Asztallábak érkezése

Milling2

Marás 2

Shipping

Szállítás

Buffer

Tároló

Assembly

Szerelés
Conveyor - Szállítószalag

Rejects

Selejt

Store

Table-Tops

Asztallapok tárolása

295



www.graphit.hu

TableFile beállításai - öröklődés

A View > Comment (nézet > megjegyzés) menüpontot kiválasztva a táblázattal

kapcsolatos tudnivalók dokumentálhatók.

A TableFile (táblázat) egy több oszlopos lista.

Az öröklődést szabályozó opciók a Format (Formátum) menüben:

Inherit Format (Formátum öröklése) vagy

Inherit Contents (Tartalom öröklése)

parancsokkal kapcsolhatók ki.

Az Inherit Contents opció kikapcsolása

után módosítható a tábla tartalma.

Az Inherit Format opció kikapcsolása

után módosítható a tábla formátuma. Ez

az opció kikapcsolja a Inherit Contents

opciót is.
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TableFile beállításai - formátum

Az adattípus kiválasztása előtt válassza ki

a teljes táblázatot (1) vagy a kívánt

oszlopot (2). Válassza ki a

Format > Format > Data Type

menüpontot és válassza ki az adattípust.

Adja meg a táblázat Dimension (méret)

értékét.
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Hozzáférés TableFile objektumhoz 
metódussal

Olvasás táblázatból:

print tablefile[1,2];

Írás a táblázatba:

tablefile[1,3] := "grinding";

tablefile[2,3] := 180;

oszlop   sor

A táblázatok esetében a Plant Simulation először az oszlopot, aztán a sort hívja

meg:

Így lehet táblázat cellájának értékét attribútumhoz rendelni:

<object>.proctime := tablefile[2,1];
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Hozzáférés TableFile objektumhoz egyedi 
indexeivel

<object>.proctime := tablefile["time","partA"];

Egy cella meghívható az oszlop és

sorindexével is.

A példában hozzárendeljük az

anyagáram objektum feldolgozási

idejéhez annak a cellának a tartalmát,

amely a 2. oszlop, 1. sorában van a

táblázatnak:
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<TableFile>.setCursor(1,1); a táblázat kurzorát a megadott cellához 

állítja

<...>.find(`[1,1]..`[*,*],<value>); érték keresése az adott tartományban

<...>.CursorX, <...>.CursorY; kurzor adott oszlophoz (CursorX)  vagy 

sorhoz (CursorY) állítása

<...>.xDim; <...>.yDim; visszatér az utolsó oszlop/sor számával

<...>.sort(3,"ascending"); táblázat sorba rendezése egy vagy több 

oszlop alapján növekvő vagy csökkenő 

sorrendben

<...>.meanValue(`[1,*]); az összes számtani értékkel tér vissza 

(real és integer) az adott tartományban

<...>.delete(`[1,1]..`[*,*]); tartomány vagy a teljes tartalom törlése

<local_variable>.create; táblázat készítése lokális változóként, 

tartalom nélkül

Metódusok listákhoz és táblázatokhoz
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Keresés TableFile objektumban

A Plant Simulation a táblázatot a kurzor pozíciójában kezdi el keresni: legyen a

kurzor az első cellában.

A Plant Simulation visszatérése true (igaz), ha megtalálta az értéket, és a kurzort

abba a cellába helyezi. A visszatérés false (hamis), ha nem találta meg az értéket.
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A Variable (változó) objektum

• Ikon:

• Kapacitás: 0

• Információs áram objektum

Jellemzők:

A Variable (változó) objektum értékek

tárolására szolgál a szimuláció hosszabb

idejére. Ugyanúgy meghívható, mint bármely

más objektum. Az értékek lehetséges

tartománya az adattípustól függ.

A Variable meghívható más objektumok vagy

metódusok által.
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5a. lecke: Az asztallapok festése

1. Nyissa meg a CompPaintshop Frame - et a FacilityComponents mappában. Adjon

hozzá egy TableFile objektumot, és legyen a neve ColorTable. Adjon hozzá egy

PaintTableTop nevű metódust.

2. Adja meg az asztalszíneket a ColorTable objektumba. A színek megegyeznek az

ikonszerkesztőnél látható állapotikon színekkel.

3. Melyik kontrollba kell megadni a

metódus meghívását?

4. Programozza le a metódust,

amelyikben a Plant Simulation lefesti az

asztallapokat a táblázatban lévő

színekkel. Szedje szét a problémát

kisebb lépésekre.

5. Ha szükséges illessze be a még

hiányzó objektumokat.
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5a. lecke: Az asztallapok festése
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5b. lecke: A TestPainting Frame

1. Nyissa meg a TestPaintshop Frame-et a TestModel mappában. Amint ki lett

bővítve a Paintshop Frame a Paintshop Frame osztályban (a

FacilityComponents mappában), a teszt TestPaintshop Frame mutatja a

változásokat.

2. Indítsa el a szimulációt, és figyelje meg, hogyan festődnek az asztallapok a

Paintshop Frame-ben.
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5c. lecke: A festési ciklus

2.Törölje a Drain objektumot, és illesszen be

egy Buffer objektumot 4 alkatrész

kapacitással.

3.Zárja be a kört a Paintshop állomással egy

Connector objektum beillesztésével.

4.Illesszen be egy metódust, aminek a

programja az asztallap objektum Quality

attribútumát GOOD - ra állítja ha az a

Part_not_ok állomásra érkezik. Emellett az

MU nevét is megváltoztatja tableTop_good

- ra.

Most bezárjuk a festési ciklust, és minden hibásan festett asztallapot

visszaküldünk a Paintshop állomásra:

1. Nyissa meg a CompPaintshop Frame osztályt.

306



www.graphit.hu

5c. lecke: A festési ciklus
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5d lecke: Frame teszt és a Paint a Plant_8-
on

Győződjön meg arról, hogy a TestPaintshop

Frame megfelelően működik.

Aztán győződjön meg arról, hogy a Paintshop

Frame a megfelelő módon viselkedik a Plant_8

Frame - en.
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StackFile, QueueFile, CardFile objektumok

A StackFile, QueueFile és CardFile objektumok egy oszlopos listák. Nem lehet

üres cellájuk. Különböző jellemzőkkel rendelkeznek a cellák adatainak olvasására,

beszúrására, stb.

StackFile (hasonló a verem adathoz)

A hozzáférés LIFO metódussal történik (Last In First Out). Az új elemek a tetejére

kerülnek, és az elsőként hozzáadott cellát távolítja el.

QueueFile (hasonló a sorhoz)

A hozzáférés FIFO metódussal történik (First In First Out). Az elemeket abban a

sorrendben menti el, ahogy a beszúrásuk történik. Az az elem kerül eltávolításra,

amely a legrégebben vár a sorban.

CardFile (hasonló a listához)

Véletlenszerű hozzáféréssel a cellapozíciót használja. Eltávolításkor a követő cellák

feljebb mozognak.
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<...>.push(<value>) érték beszúrása a StackFile vagy QueueFile
legfelső cellájába

<...>.insert(3,<value>) érték beszúrása a harmadik sorban lévő cellába 
a CardFile objektumnál, a többi cellát lefelé 
mozgatva eggyel

<...>.[] a StackFile utolsó cellájának tartalmát távolítja 
el. A többi cella eggyel feljebb mozog. Eltávolítja 
az első celláját a QueueFile objektumnak

<...>.[3] a CardFile harmadik sorában lévő cella tartalmát 
olvassa ki és távolítja el a tartalmát, a további 
cellák egy pozíciót felfelé mozognak

<...>.pop a StackFile utolsó cellájának tartalmát olvassa 
ki. QueueFile első cellájának tartalmát olvassa 
ki. A kiolvasott cellákat eltávolítja

<...>.read(3) a CardFile harmadik sorának tartalmát olvassa ki 
a cella eltávolítása nélkül

<...>.dim visszatér az utolsó sor sorszámával

StackFile, QueueFile, és CardFile metódusai
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10. fejezet

Műveletek

Adattípusok konverziója 
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Logikai műveletek

A logikai műveletek igaz vagy hamis (true,

false) értékkel térnek vissza.

Használhatók az AND, OR és NOT

műveletek.

AND TRUE FALSE

TRUE TRUE FALSE

FALSE FALSE FALSE

OR TRUE FALSE

TRUE TRUE TRUE

FALSE TRUE FALSE

NOT NOT TRUE  FALSE

NOT FALSE  TRUE

= FALSE = FALSE  TRUE

TRUE = TRUE  TRUE

/= FALSE /= TRUE TRUE
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Integer (egész) számok műveletei

+

-

*

//

\\

/

=

/=

>

<

>=

<=

összeadás

kivonás

szorzás

egész osztás

modulusz  

osztás

egyenlő

nem egyenlő

nagyobb, mint

kevesebb, mint

nagyobb vagy egyenlő

kisebb vagy egyenlő

integer

integer

integer, real

boolean

Visszatérési érték

17//5 = 3

17\\5 = 2
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Real (valós) számok műveletei

összeadás
kivonás
szorzás
osztás

egyenlő
nem egyenlő
nagyobb, mint
kevesebb, mint

nagyobb vagy egyenlő
kisebb vagy egyenlő
nagyjából egyenlő

kevesebb vagy nagyjából egyenlő
nagyobb vagy nagyjából egyenlő

+
-
*
/

=
/=
>
<

>=
<=
= =

<= =
>= =

real

boolean

Visszatérési érték
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String (szöveg) műveletek

+

=

/=

==

összeadás

egyenlő

nem egyenlő

nagyjából egyenlő

toLower

toUpper

copy

incl

omit

strlen

pos

boolean

string

string

integer

Visszatérési érték
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Adattípus konverziós metódusok

A különböző adattípusokkal a

megfelelő műveleteket lehet

végrehajtani. Nem minden

műveletet lehet minden

adattípussal végrehajtani.

Mielőtt a különböző

adattípusokon műveleteket

végezne, egyforma típusúvá

kell konvertálni azokat. Csak

ez után tudja a Plant

Simulation végrehajtani a

műveleteket rajtuk.

Metódus Visszatérés

to_str(<...>) string

num_to_bool(<integer>) boolean

bool_to_num(<boolean>) real

str_to_num(<string>) real

str_to_bool(<string>) boolean

str_to_time(<string>) time

str_to_date(<string>) date

str_to_datetime(<string>) datetime

str_to_length(<string>) length

str_to_weight(<string>) weight

str_to_speed(<string>) speed

str_to_obj(<string>) object
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11. fejezet

Ciklusok
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A For-Loop ciklus

for
számláló változó

kezdőérték

utasítások;

végérték

downto

loop

next;

to

A for ciklus egy tartományon halad végig a kezdőérték és a végérték között. A

számláló változónak integer adattípusúnak kell lennie és megadja a ciklus kezdetét.

Amikor a ciklus egy lépése lefut, a Plant Simulation hozzáad 1-et a számláló

változóhoz (a to beállítással) vagy levon 1-et (a downto beállítással). Addig fut a

ciklus, amíg a számláló változó értéke el nem éri a végértéket.
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Példa For-Loop ciklusra

i: a számláló változó

1: lépték
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repeat utasítások; feltétel;until

A Repeat Until ciklus

A Plant Simulation a repeat ciklust legalább egyszer lefuttatja. A Plant Simulation

akkor lép ki a ciklusból, amikor a feltétel értéke true (igaz).

Ha a feltétel soha nem válik igazzá, akkor a Plant Simulation végtelenül futtatja azt.

Egy végtelen ciklus a Shift+Alt+Ctrl billentyűkkel szakítható meg. Ekkor megjelenik

a hibakereső.
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Példa Repeat-Until ciklus
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A While-Loop ciklus

while feltétel utasítások;loop end;

A Plant Simulation addig futtatja a while ciklust, amíg a feltétel értéke true

(igaz).

Amikor az utasítások teljesen feldolgozásra kerülnek, a Plant Simulation

még egyszer leellenőrzi, hogy a feltétel igaz.
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Példa While-Loop ciklus
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6. lecke: Ciklusok

1. Készítsen egy Loops nevű Frame-et az Exercises mappában.

2. Adjon hozzá egy metódust és programozzon egy olyan ciklust, amely

1-től 10-ig halad végig értékeken.

3. Írassa ki a számláló változó értékét a konzolon.

4. Lépkedjen végig a metóduson. A Watch Window ablakban is meg

lehet jeleníteni a számláló változót.
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12. fejezet

Feltételes várakozások - waituntil, 

stopuntil
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A Waituntil és a Stopuntil utasítások

waituntil feltétel integerprio

A waituntil utasítás egy metódus futásának ideiglenes felfüggesztésére szolgál – egy

feltételnek megfelelően.

Ha a feltétel nem igaz, akkor a Plant Simulation megszakítja a metódus futását ott.

Ideiglenesen felfüggeszti a metódus futását, de minden jellemzőjét (változók, stb.)

elmenti. Ez után figyeli a feltételt, miközben a szimuláció futása folytatódik.

Amint a feltétel igazzá válik, megszakítja a futását a metódusoknak és ezt a metódust

folytatja, ott ahol abbahagyta.

A feltételnek ehhez boolean típusúnak és true értékűnek kell lennie.

stopuntil feltétel integerprio
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A Waituntil és a Stopuntil utasítások

Amikor több metódus vár ugyanannak a feltételnek a teljesülésére, a Plant

Simulation egyszerre aktivizálja újra azokat, és abban a sorrendben futtatja le őket,

ami a prio kifejezésben megadott.

A waituntil utasítással ideiglenesen felfüggesztett metódusok esetében a fordító

újra kiértékeli a feltételt, mielőtt a különálló metódusokat lefuttatná.

A stopuntil utasítással ideiglenesen

felfüggesztett metódusok esetében a

Plant Simulation nem értékeli ki újra

a feltételt az egyes metódusok

futtatása előtt. Mindet egyszerre

aktivizálja újra és a megadott

prioritás szerinti sorrendben futtatja

le őket.

Az egy időben ideiglenesen felfüggesztett metódusok maximális száma (Maximum 

number of suspended methods) az Options > Simulation menü alatt adható meg 
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13. fejezet

Egy objektum tartalma

Fel- és lerakodás
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Receiving

TableLegs

Asztallábak érkezése

Fel- és lerakodás

CutToSize

Méretrevágás

Milling1

Marás 1

Paintshop

Festőüzem

Quality

control

Minőség-

ellenőrzés

Packing

Csomagolás

Milling2

Marás 2

Shipping

Szállítás

Buffer

Tároló

Assembly

Szerelés
Conveyor - Szállítószalag

Rejects

Selejt

Store

Table-Tops

Asztallapok tárolása
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A Container (konténer)

Rá lehet rakodni és szállítani

bármilyen MU-t. Ezzel lehet

modellezni pl: palettákat, stb.

Meg lehet adni az x és y irányú

kapacitását. A Container nem

vizsgálja a rá töltött objektum

hosszát.

A Container objektum mátrix-alapú tárolóhelyekkel rendelkezik.
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Hozzáférés objektum tartalmához

A cont metódus használható az anyagáram objektumok és a Container tartalmának

lekérdezésére. Formátuma: <object>.cont.

@.move(MillingMachine)*

saw.cont.move(MillingMachine)

A cont metódus rendszerint a következő MU - val tér vissza, amelyik kész az

objektumból való kilépésre, akkor is, ha másik MU - n található is (pl. Container).

* @, amikor az aktuális MU hívja meg a metódust

Saw MillingMachine Saw MillingMachine
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Hozzáférés objektum tartalmához

A felrakodott Container tartalmához először az állomás tartalmát, majd a rajta lévő

Container tartalmát lekérdezve lehet.

Ez akkor is igaz, ha egymáson lévő Container - ekről van szó. (... .cont.cont.cont...)

@.cont.move(MillingMachine)

Saw.cont.cont.move(MillingMachine)

Saw MillingMachine

A cont metódus használható egy másik MU Container - re mozgatásához:

@.move(MillingMachine.cont)

Saw.cont.move(MillingMachine.cont)

Saw MillingMachine
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Anyagáram objektumok tartalma

• Mielőtt egy objektum tartalmához fordulna, győződjön meg, hogy az

objektumnak van tartalma. Használja valamelyik állapotjelző attribútumot az

anyagáram objektum ellenőrzésére.

• Az anyagáram objektumnak különböző állapotai lehetnek, amelyeket le lehet

kérdezni és be lehet állítani attribútumokkal. A megfelelő metódus visszatérése

true (igaz), ha az objektum abban az állapotban van, és false (hamis), ha nem.
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Anyagáram objektumok tartalma

334

<object>.empty; visszatérése TRUE, ha nincs MU az állomáson, 
FALSE ha van MU rajta

<...>.full; visszatérése TRUE, ha minden állomása a 
ParallelProc - nak vagy a Buffer - nek foglalt, 
FALSE ha nem ez a helyzet

<...>.occupied; visszatérése TRUE, ha legalább egy MU van az 
állomáson, FALSE, ha nincs MU rajta

<...>[2,1].occupied; visszatérése TRUE, ha van MU a megadott
állomáskoordinátákon

<...>.cont.finished; visszatérése TRUE, ha az MU feldolgozási ideje 
eltelt és az MU kész elhagyni az objektumot

<...>.ready; visszatérése TRUE ha az objektum megtelt, és van 
kilépésre kész MU. A kombinációja az occupied és 
cont.finished metódusoknak (Megjegyzés: nem 
figyelhető meg waituntil paranccsal)
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Szerelési ciklus készítése

Szerelési (assembly) ciklust kell készíteni. Az asztallapok felkerülnek a palettákra,

amely elviszi azokat a szerelési állomásra. Itt az asztallábak hozzáadódnak az

asztallapokhoz. Ezután az összeszerelt asztalok elhagyják a szerelési állomást, a

paletták visszamennek a szerelési állomásra, újra használatra.

A végrehajtáshoz a következőket 

kell tenni:

1. Container felrakodás

2. Container lerakodás

3. Fel- és lerakodási ciklus

4. A szerelési folyamat
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TransferStation – Rakodóállomás

Jellemzők:

• Ikon:

• Kapacitás: 1

• Aktív anyagáramlás objektum

A TransferStation az MU-k egyik

objektumról egy másikra törté-

nő mozgatását végzi.

A mozgatás típusa lehet:

• Load (felrakodás),

• Unload (lerakodás),

• Reload (feltöltés),

• Move (átmozgatás).

336



www.graphit.hu

TransferStation – Rakodóállomás

Sensor segítségével a

TransferStation az

MU-kat pl. egy SingleProc - ról

egy Line objektumra rakodja.

Meg kell határozni:

• az állomás típusát,

• a forrást (Parts Station),

• a célállomást (Target Station), ill.

• hosszorientált objektum esetében

a Sensor pozícióját.
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TransferStation – Rakodóállomás

Megadható a feldolgozási idő.

338

Lekérhetők az állomás statisztikai adatai is.
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PickAndPlace – Robot komponens

339

Jellemzők:

• Ikon:

• Kapacitás: 1

• Aktív anyagáramlás objektum

A PickAndPlace nevű objektum a

darabok egyik állomásról egy másikra

történő elhelyezését végzi.

Az Angles Table (szög táblázat)

tartalmazza a robot körül elhelyezkedő

állomások szögét a robothoz képest.

A Times Table (idők táblázata) pedig azt tartalmazza, hogy az egyes

állomások között mennyi időt vesz igénybe a robot forgása.

Mindkét táblázat egyéni igényeknek megfelelően testreszabható.
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PickAndPlace – Robot komponens

A Times fül alatt a helyreállítási- és a

teljes ciklusidő adható meg.

A Statistics fül alatt (mint minden

anyagáram objektumnál) találhatók a

robotra vonatkozó statisztikák.

A PickAndPlace robot a (jobb klikk)

Calculate Angles parancs segítségével

számítja ki a szomszédos objektumok

elhelyezkedési szögét.



www.graphit.hu

7a. lecke: Felrakodás

1. Adja hozzá a Frame_5 nevű Frame - et az Exercises mappához.

2. Illessze be az ábrán látható állomásokat. A SourcePart Source hozza létre az

asztallapokat, a SourcePalette Source pedig a palettákat.

3. Illesszen be két szállítószalagot (Line) és kapcsolja össze azokat a többi elemmel.

4. Illesszen be egy TransferStation

objektumot, húzza rá az Entrance

objektumot és a kapcsolódó

szállítószalagot. Az Entrance a

Part Station, a szállítószalag a

Target Station, a szenzor helye

pedig 2m-nél van.

5. Tesztelje a felrakodást. Ne

feledje, hogy mindegyik palettára

egy asztallapnak kell kerülni.
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7b. lecke: Lerakodás

1. Készítsen másolatot a Frame5 Frame - ből az Exercises mappában Frame6 néven.

2. Adjon hozzá egy további TransferStation, és Drain, illetve egy Exit állomást.

3. Készítsen egy második Line szállítószalagot.

4. A Target Station (célállomás) az Exit, a Part Station a Line1, a szenzor legyen

8m környékén.

5. Engedje meg az MU -

knak a feltorlódást a

szállítószalagon, és

ellenőrizze a lerakodás

működését.

6. Adja meg a fel/lerakodás

idejét (pl. 10 sec) a Times

fülön a TransferStation

állomások ablakában.
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5. A Source_Palette 10 darab

palettát készít egyszer

(használja a Number adjustable

opciót).

343

7c. lecke: A paletta ciklus

1. Készítsen másolatot a Frame6 Frame - ből az Exercises mappában Frame7 néven.

2. Törölje a Drain komponenst, és alakítsa át a második Line elemet teljes körré (jobb

egérkattintással lehet pontokat hozzáadni).

3. Törölje a TransferStation1 komponenst, és illesszen be a helyére egy

PickAndPlace robot komponenst, majd kösse össze a Line1 és Exit állomásokkal.

4. Az Exit állomás szerepe csupán

az, hogy levegye az asztallapokat

a konténerről (Container). Ezért a

feldolgozási ideje legyen nulla.
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7c. lecke: A paletta ciklus

6. Győződjön meg arról, hogy az MU-k fel tudnak torlódni.

7. A szállítószalagról való lerakodást a PickAndPlace robot fogja végezni. Ennek

érdekében be kell állítani egy Sensor – t a Line1 komponensen (kb. 8 m-nél).

344

8. A Control mezőbe kattintva jobb egérgombbal, válassza ki a Create Control

parancsot. Az OnSensor nevű metódus fogja szabályozni a Sensor – t.
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7c. lecke: A paletta ciklus
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Hozzáférés hosszorientált objektum 
tartalmához

A hosszorientált objektumok tartalmához (pl. a rajtuk lévő MU - khoz és konténerekhez)

az alábbi metódusokkal lehet hozzáférni:

<object>.cont; a következő kilépésre kész MU - val tér vissza.

<...>.mu(3); a 3-as számú kilépésre kész MU - val tér vissza.

<...>[x,y].cont; a mátrix [x,y] pozíciójában lévő MU - val tér vissza.

Például:

<singleproc>.mu(1).move; az 1-es számú MU-t a kilépési állomásra

mozgatja.

@.move(<parallelproc>[2,2]); az MU-t az objektum [2,2] pozíciójára

mozgatja.

Csak olyan objektum tartalmához lehet hozzáférni, amelyik éppen tartalmaz MU -

kat!
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8a. lecke: A lábak kapcsolása az 
asztallapokhoz

1. Készítsen egy CompAssemblyFrame Frame - et a FacilityComponents

mappában és illessze bele az ábrán látható objektumokat.

2. A ParalleProc négy állomással rendelkezik a 4 asztalláb számára, és nincs

feldolgozási ideje.

Ebben a Frame-ben a szerelési folyamatot modellezzük. Az asztallapok palettákon

érkeznek, lerakodásra kerülnek, majd az asztallábak hozzájuk kapcsolódnak.

3. Programozza a metódust, amely az

összeszerelést modellezi. Hogyan

lehet a különböző eseményeket

kezelni?

4. Készítsen ikont a Frame számára és 

animációs pontokat. 
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8a. lecke: A lábak kapcsolása az 
asztallapokhoz
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8b. lecke: Az Assembly és
CompAssemblyComplete tesztje

1. Készítsen másolatot a Frame7 Frame - ből, és legyen a másolat neve:

TestAssemblyFrame.

2. Cserélje ki az Assembly SingleProc objektumot a CompAssemblyFrame nevű

Frame - re, ami az imént készült el.

3. Ellenőrizze a szerelés funkcionalitását.

4. Cserélje ki a SourcePart, SourceLegs és Drain objektumokat Interface

objektumokkal.
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8c. lecke: TestAssembly és az új Plant

1. Készítsen másolatot a Plant_8 komponensből Plant_9 néven

2. Cserélje ki a CompAssembly nevű Frame komponenst a

CompAssemblyComplete nevű Frame komponenssel a szimulációs modellben.

3. Indítsa el a szimulációt és figyelje meg, hogy a várt események jelennek-e meg a

képernyőn.
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14. fejezet

Metódusok meghívása

Frame kontrollok
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Metódusok meghívása

CutToSize

Méretrevágás

Milling1

Marás 1

Paintshop

Festőüzem

Quality

control

Minőség-

ellenőrzés

Packing

Csomagolás

Receiving

Table-Legs

Asztallábak érkezése

Milling2

Marás 2

Shipping

Szállítás

Buffer

Tároló

Assembly

Szerelés
Conveyor - Szállítószalag

Rejects

Selejt

Store

Table-Tops

Asztallapok tárolása
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Frame kontrolláló metódusok

Válassza ki az

Tools > Select Controls

menüpontot és adja meg a metódusok neveit a

kívánt helyeken. Ezek arra szolgálnak, hogy a

Frame objektumok eseményeihez is lehessen

készíteni függvényt.
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Frame szintű metódushívás

A ShiftCalendar használható Frame kezelésére

is nem csupán egyes állomásokra. Ezért a

ShiftCalendar Resources fülén a “~.”

szimbólummal megadható a keret neve.

Ez után készíthető egy metódus, amely a

frame ikonját megváltoztatja.

A metódusnak akkor kell aktivizálódnia,

amikor a ShiftCalendar átállítja a frame

pause vagy unplanned attribútumát. Az

unplanned olyan idő, amikor nincs műszak,

szünet van.

A szövegmezőben a metódus a Pause/Unplanned time esetén kontrollálja az

állapotváltozások esetén a történéseket.
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1. Készítsen egy másik ikont a Packing Frame

számára az ikonszerkesztőben egy másik

névvel.

2. Adja meg a PauseIcon metódust, mint a

CompPacking Frame kontrollját.

3. Aktivizálja a ShiftCalendar objektumot a CompPacking Frame - hez, és a

PauseIcon metódust a Frame pause eseményéhez.

4. Készítse el a megfelelő metódust, amely aktivizálja a megfelelő ikont,

amikor a Frame állapota módosul.

 working

paused 

9. lecke: Frame kontrollálás
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9. lecke: Frame kontrollálás
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15. fejezet

Dolgozók (worker) hozzáadása
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Worker (dolgozó) objektum

Dolgozó kezeléséhez a kívánt helyen a következő komponensek szükségesek:

Workplace, Broker és WorkerPool. Mindegyik objektum a Resources fülön

található a Plant Simulation komponenspalettán.

Ebben a részben a Packing

komponenshez dolgozók (worker)

objektumok kerülnek hozzáadásra.
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Worker – állomáshoz rendelés

Egy állomást a munkahelyhez (workplace) 

rendelni a következő módon lehet:

• Meg kell adni az állomás útvonalát a 

Station mezőben.

• Az állomást rá kell húzni a munkahelyre 

(húzd és ejtsd módszerrel).

• A munkahelyet az állomás közelében 

elhelyezve automatikusan 

hozzárendelődik az állomás a 

munkahelyhez.
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Worker – szolgáltatások definiálása

Meg kell nyitni az állomás ablakát

(SingleProc, ParallelProc) és ki kell

választani az Importer fület.

Aktivizálni kell az Importer - t.

Ki kell választani azt a Broker - t, amely a

szolgáltatásokat kezeli.

Meg kell nyitni a Services táblázatot, és

meg kell adni a megfelelő értéket az

alternatívákra.
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Worker – Dolgozó definiálása

Meg kell nyitni a WorkerPool - t

Meg kell adni a Broker objektumot.

Meg kell nyitni a Creation Table - t

(készítési táblát) a szükséges

dolgozók definiálására.

Meg kell adni a dolgozó által nyújtott

szolgáltatást.
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10. lecke – Dolgozó hozzáadása

1. Készítsen másolatot a CompPacking Frame -

ből, legyen a neve CompPackingwithWorker.

2. Illesszen be egy WorkPlace, WorkerPool és

Broker komponenst.

3. Kapcsolja össze őket (Broker és Packing és

WorkerPool, Packing és WorkPlace,

ShiftCalendar és WorkerPool)

4. A Packing állomásnál aktivizálja az Importer - t

és kapcsolja össze a Broker komponenssel

5. Készítsen egy teszt környezetet, majd készítsen

egy új Plant komponenst a dolgozóval

csomagolást használva.

Ellenőrizze le, hogy mi történik, ha a Packing állomást nem kontrollálja a 

ShiftCalendar.
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16. fejezet

Egyéb funkciók
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Metódus egyedi jellemzőként

Metódus felvehető egyedi

jellemzőként is, ha az adattípus

method-ként van megadva. Ezek

olyan metódusok, amelyek az

objektumban tároltak és kezeltek.

Az ilyen metódusokkal az adott

anyagáram objektumra jellemző

metódusok készíthetők.
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Metódus egyedi jellemzőként

Ez a metódus nem egy valódi Method objektum, de egy metódus típusú attribútuma

egy objektumnak.

Ez a metódus az objektum része, ami megmarad az objektum mentésekor,

másolásakor is.

A kifejezés:

self.name_of _Method

egyedi jellemzőként programozott

metódust hív meg.
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Egyéb metódusok

 callEvery(<path>,<method>,<argument>)

Meghívja azokat a metódusokat, amelyeket a method paraméter megad a <path>

Frame-ben. Az argumentumok a metódus hívásának megfelelően adódnak át.

 ref(<method>).methCall(<time/date/datetime>,<argument>)

Meghívja a metódust a <time> által megadott idő elteltével. A <datetime> vagy 

<date> paramétereknél a Plant Simulation az EventController alapján számol. Az 

argumentumok a metódus hívásának megfelelően adódnak át.

 wait(<real>)

A hívások futásának láncát megszakítja a <real> paraméter által megadott

másodpercig. Az EventController egy MethWakeup eseményt kap.
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Metódusok beépített ikonjai
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• Ikon:

• Kapacitás: tetszőleges

• Hosszorientált anyagáram objektum

Track (pálya) objektum

Jellemzők:

Megadható a hossza (Length) és a

kapacitása (Capacity). Az egyetlen

mozgó anyagáram objektum a

Transporter ami közlekedni tud rajta.

A Container és az Entity a helyén

marad és nem mozog rajta.

A destination list tartalmazza azokat

az objektumokat, amelyekhez a Track

hozzá tud férni.
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Transporter (szállító) objektum

Megadható a gyorsulás

(Acceleration) a végsebesség

(Final speed) a

szövegmezőkben.

Megadható, hogy a feltölés

módja: Matrix load bay vagy

Load bay length, a kapacitás és

a szenzorok helye.

A Battery fül alatt megadhatók azok a jellemzők, amelyek az üzemanyagcellával

(akkumulátorral) működő Tranporter objektumokat jellemzik.
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Kontrollok

Destination control: egyszer aktiválódik, amikor a Transporter elérte a célját.

Collision control: akkor aktiválódik, ha két Transporter összeütközik.

Speed control: akkor aktivizálódik, ha a Transporter eléri a végsebeségét.

A Controls fülön megadhatók azok a 

metódusok, amelyek a Transporter és a 

Track objektumokat kontrollálják.

Driving control: annak a Track

objektumnak a megadása, amelyen a

Transporter mozog.

Destination: ha nincs kilépési kontroll a

Tracken, akkor azt adja meg, hogy kilépési

ágra mozog a Transporter a pálya végén.
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Transporter metódusai

A Source tud készíteni Transporter objektumokat az Entity

vagy a Container objektumokhoz hasonlóan.

A Plant Simulation ezt a következő Track objektumra mozgatja 

az összekötésekkel vagy metódussal. 

A Transporter emellett képes a Track-en mozgásra a saját energiájából. Ha a Track

objektumok össze vannak kapcsolva, akkor az egyikről a másikra mozog.

Használja a következő formátumot a Transporter megfelelő objektumra

helyezéséhez:

.MUs.transporter.create(track);

.MUs.transporter.create(track,3.1); -- a hely méterben a Tracken
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Transporter metódusai

A Transporter a Track - en azokkal a beállításokkal halad,

amelyek a szimuláció futtatásakor meg lettek adva.

A Transporter megállítható, mozgása folytatható, és visszafelé

is mozgatható.

A Track cont metódusa használható a Transporter meghívására. A @ azonosító a

Transporter - t hívja meg:

@.stop;

@.continue;

@.backwards := true;

track.cont.stop; ...
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MU-k transzportálása

2. Készítsen egy Init metódust, amely elkészíti a Transporter - t a Track - en a

szimuláció indulásakor.

3. Melyik objektumnak kell ezt a szimulációs modellben kontrollálni? Programozza a

loading és unloading metódusokat ezen események koordinálására.

4. Győződjön meg róla, hogy a metódusok megfelelően működnek, akkor is, ha az

MU-k feltorlódnak a Drain előtt.

A Transporter a Conveyor1 által adott

alkatrészek Conveyor2-höz

szállítására szolgál, egyszerre egy

alkatrészt szállítva.

1. Készítsen egy Frame -et és illessze

bele az objektumokat az ábra

szerint. A Track 10 méter hosszú.
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MU-k transzportálása
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Tanfolyam

Plant Simulation 9

3. modul: Adatkezelés



www.graphit.hu

1. fejezet

Statisztika gyűjtő objektumok
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Elrendezés

CutToSize

Méretrevágás

Milling1

Marás 1

Paintshop

Festőüzem

Quality

control

Minőség-

ellenőrzés

Packing

Csomagolás

Receiving

Table-Legs

Asztallábak érkezése

Milling2

Marás 2

Shipping

Szállítás

Buffer

Tároló

Assembly

Szerelés
Conveyor - Szállítószalag

Rejects

Selejt

Store

Table-Tops

Asztallapok tárolása
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A feladat

Meg akarjuk vizsgálni a Bufferek terheltségét a gyárunkban. Ennek érdekében több

Gauge objektumot és Plotter objektumot illesztünk a szimulációs modellbe.
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Display objektum

• Ikon:

• Kapacitás: 0

• Aktív felhasználói felület objektum

Jellemzők :

A Display értékek szöveges, illetve kör-

vagy oszlopdiagramm formájú

megjelenítésére szolgál.

A Path mezőben a figyelni kívánt

objektum és a figyelni kívánt attribútum

adható meg.

A Display a Comment mezőben

megadott szöveget a szimulációs

modellben a Frame - en megjeleníti.

Megjegyzés: a Path megadása előtt az Active állapotot be kell állítani.
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Display – Megjelenítés fül

Először meg kell adni a megjelenítés

típusát: Text (szöveg), Bar

(oszlopdiagram) vagy Pie

(kördiagram). Mostani célunkhoz a

Bar megfelelő.

Diagramok esetében megadhatók a

Maximum és Minimum értékek a

megjelenítés áttekinthetőbbé tételére.

Továbbá megadható az összegyűjtött

értékek megjelenítésére szolgáló szín

(Color) is.
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Chart (grafikon  Plotter) objektum

• Ikon:

• Kapacitás: 0

• Aktív felhasználói felület objektum

Jellemzők :

A Chart értékek változását rögzíti és

görbével ábrázolja.

Míg a Display egy változó aktuális

értékét mutatja, addig a Chart több

változó aktuális értékének

mutatására szolgál.
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Chart - adatforrások

Data Source:

A table file-ban megadhatók az

adatforrások az első oszlopban.

A nulladik oszlopban használt

értékek jelennek meg

feliratként.

Mode:

Kiválasztható a Plot, a Sample

vagy a Watch mód.
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Chart — megjelenítés típusa

Category:

Legyen Plotter a grafikon

kategóriája.

Chart Type:

Legyen Line a grafikon típusa

Data:

Legyen in Column az

adatforrás.
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Chart — tengelyek definiálása

Number of values:

A kirajzoláshoz a grafikonban

tárolt értékek száma.

Scrollbar:

Görgetősáv megjelenítése a

grafikon számára, a tárolt

értékek mentén lehet görgetni.

Range:

Az y tengely tartományának

megadása. A maximális

elemszám 100 lehet.
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Chart — Címke azonosító

Title:

A grafikon címének megadása

Legend:

A felirat pozíciójának megadása

a lenyitható menüből kiválasztva.
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Chart — Színdefiníció

A rajzolási vonalvastagság

megadása az összes

bemeneti csatornához a

táblázatban.
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Az összegyűjtött értékek megjelenítése

A megjelenítési ablak megnyitásához kattintson a

Chart objektumra jobb egérgombbal és válassza ki

a Show parancsot.

A Chart a megadott értékekkel jelenik meg.
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1. lecke: Gauge és Chart a gyárban

Illesszen be néhány Gauge objektumot a Frame-be. A Gauge objektumok arra

szolgálnak, hogy megjelenítsék az MU-k számát a komponensek pufferében a Watch

módban oszlopgrafikonként, vagy szövegként (String). Az objektum másolható és

beilleszthető vágólapon keresztül, így csak a másolaton kell változtatni a beállításokat.

Illesszen be egy Chart objektumot a modellbe, és használja szintén az MU-k számának

megjelenítésére Plot módban (Y - Channels).
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2. fejezet

Metódusok statisztikai értékek 

összegyűjtésére
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Hogyan kapcsolódik a gyárunkhoz?

CutToSize

Méretrevágás

Milling1

Marás 1

Paintshop

Festőüzem

Quality

control

Minőség-

ellenőrzés

Packing

Csomagolás

Receiving

Table-Legs

Asztallábak érkezése

Milling2

Marás 2

Shipping

Szállítás

Buffer

Tároló

Assembly

Szerelés
Conveyor - Szállítószalag

Rejects

Selejt

Store

Table-Tops

Asztallapok tárolása
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Összefoglalás: 
Lista és táblázat metódusok

391

<TableFile>.setCursor(1,1); a megadott cellába állítja be a
táblázat kurzorát

<...>.find(`[1,1]..`[*,*],<value>); érték keresése a megadott
tartományban

<...>.CursorX, <...>.CursorY; a kurzor beállítása az oszlophoz
(CursorX) vagy a sorhoz (CursorY)

<...>.xDim; <...>.yDim; visszatér az utolsó
oszloppal/sorral, amely adatot
tartalmaz

<...>.sort(3,”down"); egy vagy több oszlop sorba
rendezése a táblázatban növekvő,
vagy csökkenő sorrendben

<...>.meanValue(`[1,*]); a megadott tartományban lévő
értékek átlagával tér vissza

<...>.delete(`[1,1]..`[*,*]); adott tartomány, vagy a teljes
tartalom törlése

<local_variable>.create; tábla lokális változó készítése
tartalom nélkül



www.graphit.hu392

<TableFile>.setDataType(1,"real") oszlop adattípusának beállítása

< >.cutRow(1); sor kivágása

< >.insertColumn(1); a megadott oszlop jobb oldalához új
oszlop beszúrása

< >.readFile("C:\\... .txt"); fájladat betöltése egy Plant
Simulation táblázatba

< >.openfile("C:\\... .txt"); a megadott fájl megnyitása

< >.readFileRow; annak a fájlsornak a kiolvasása, ahol
a kurzor található, és beillesztése a
listába vagy táblázatba

< >.FileCursor := <5>; a belső fájl kurzor beállítása a
megadott sorba

< >.closeFile; megnyitott fájl bezárása

< >.writeFile("C:\\... .txt"); Plant Simulation táblázat adatainak
fájlba írása

Lista és táblázat metódusok
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Összefoglalás: Teljes statisztika -
Complete Statistics Table

A teljes statisztika táblázat (complete statistics table) az összes objektum,

anyagáram objektum és mozgó objektum statsztikai értékét gyűjti össze.

A statistics metódus egy objektumra visszatér az adott objektum statisztikai

értékeivel: <object>.statistics;

A táblázatban 111

oszlopban láthatók a

statisztikai értékek,

amelyek

oszlopindexekkel

elérhetők.

A statisztikai adatok jobban áttekinthetők HTML jelentésként view -> 

Statistics Report (F6)

393



www.graphit.hu

A statistics metódus – hozzáférés a teljes 
statisztikához

A statistics metódus megnyitja a teljes statisztika táblázatot. Az alapértelmezett

paraméter egy objektum, például az aktuális MU.

A teljes statisztika tábla megjeleníthető a képernyőn, táblázatba vagy fájlba írható:

A teljes statisztika táblázat különálló értékeihez azt először táblázatba kell írni,

például egy lokális változóba.

<objektum_neve>.statistics(<táblázat>);

• Ha nincs paraméter: Táblázat megjelenítése a képernyőn.

• Táblázat argumentumként: Az értékek kiírása a táblázatba, ami lehet egy

TableFile objektum vagy egy lokális változó.

• Szöveg argumentum: Az értékek fájlba írása ezzel a névvel.
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Statisztikai értékek/attribútumok 
lekérdezése

Számos metódus alkalmas anyagáram

objektumokra összegyűjtött értékek

lekérdezésére, mint például: statNumIn,

statNumOut, stb.

<Változó> := <objektum>.statNumIn;

Az objektum összes attribútuma és metódusa

megjeleníthető az objektum kiválasztása után

az F3 billentyű lenyomásával.
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2a lecke: Hozzáférés statisztikai adatokhoz

Beleírja az MU

azonosítóját az első

oszlopba, és az első

nem „foglalt” sorába a

táblázatnak.

A névleges végighaladási időt

beleírja a második oszlopba.

Az RecordTPT metódus a

CompShipping Drain belépési

kontrolljaként használható.
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Adat kigyűjtés attribútum alapján

Számos esetben egy bizonyos termékről van szükség információra, ami egy

attribútummal különböztethető meg a többitől.

Ez a lecke megmutatja, hogyan lehet attribútum alapján adatokat összegyűjteni,

esetünkben az asztal színe alapján.
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2b lecke
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2b lecke: Keresés táblázatban
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2c lecke: Indexek használata táblázatban

400
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3. fejezet

Plant Simulation táblázat mentése 

szövegfájlként
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Miért mentsünk táblázatot szövegfájlba?

Egy objektum, például egy Plant Simulation TableFile adatai elmenthetők

szövegfájlba. Így az összegyűjtött adatok más alkalmazásban is felhasználhatók.

Példa: Plotter

Ha egy Plotter által összegyűjtött értékeket szeretnénk használni egy MS Excel

táblázatban, illesszünk be egy metódust a Plotter helyett a Frame-be, és írjuk az

értékeket a táblázatba. Ez után ez a Plant Simulation táblázat elmenthető

szövegfájlként, ami az MS Excelben megnyitható és tovább kezelhető.
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Értékek összegyűjtése és táblázatba írása

Ezt a metódust Interval kontrolljaként készítettük el egy Generator objektumnak.

Minden percben rögzíti a Buffer - ben az MU-k számát, és az EventController-ből az

aktuális időpillanatot . Ez után az értékek egy Plant Simulation táblázatba írhatók,

és szövegfájlként elmenthetők.
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Értékek összegyűjtése és táblázatba írása
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Plant Simulation táblázat beállításai

Mielőtt egy Plant Simulation táblázatot

szövegfájlba mentene:

Válassza ki a File > Format menüpontot.

Győződjön meg arról, hogy a Decimal separator

(decimális elválasztó) period (pont).

Ha lehetséges, akkor legyen másodperc az

időformátum.

Ezzel elkerülhető, hogy az MS Excel hibásan

olvassa be az adatokat.
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Plant Simulation táblázat mentése 
szövegfájlba

A Plant Simulation táblázat szövegfájlként mentéséhez:

Példa:

TableFile.writeFile("C:\\<folder>\\<filename>.txt");

1. Válassza ki a File > Save As Text

menüpontot

Adja meg a fájl nevét és válassza ki a

mappát.

2. Használja a writeFile metódust.

Ez felülírja az esetleg meglévő fájlt.
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4. fejezet

Szövegfájl betöltése Plant Simulation 

táblázatba
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Szövegfájl betöltése

Szövegfájl betöltése a Plant Simulation rendszerbe:

<TableFile>.readFile("D:\\Files\\TableX.txt");

<TableFile>.openFile("D:\\Files\\TableX.txt");

<TableFile>.readFileRow;

Ha a szövegfájlt sorról sorra kívánja betölteni, először meg kell nyitni a fájlt. A fájlnak

van egy belső kurzora.

A táblázatnak, amelybe az adatokat be kívánja tölteni, léteznie kell a Frame - en

belül, vagy létre kell azt hozni az alábbi módon:

.InformationFlow.TableFile.createObject(current,10,30);
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Gyártási tábla importálása

Példa gyártási adatok a Source számára, az alkatrészek

neveivel és darabszámukkal.

A betöltendő szövegfájlban az oszlopokat tabulátornak

vagy pontosvesszőnek kell elválasztani.

(összehasonlítandó a File > Format beállításaival a Plant

Simulation táblázatban).
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5. fejezet

Interfész más alkalmazások felé
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A Plant Simulation három típusú szabványos interfészt nyújt más alkalmazások felé:

Fájl interfészek

– DDE (Dynamic Data Exchange)

– ODBC (Open Database Connectivity)

– SQL/Oracle (SQL – Structured Query Language)

– Socket

– XML (Extensible Markup Language)

– SDX (Simulation Data Exchange)

Kommunikációs interfészek (nem része ennek a tanfolyamnak)

– C Interface

– Active/X

Kontrol interfészek (nem része ennek a tanfolyamnak)

– COM RemoteControl Interface

– HTML

Szabványos Plant Simulation interfészek
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DDE interfész

A DDE Interface a Plant Simulationbe integrálva lehetővé teszi a Windows DDE

rendszer használatát. A Plant Simulation lehet DDE szerver vagy kliens.

A Plant Simulation, mint DDE kliens: Lehetővé teszi tetszőleges adat átküldését

a szimulációs modellből más alkalmazásokba, mint például: Microsoft Access,

vagy MS Excel vagy MS Word.

A Plant Simulation, mint DDE - szerver: Más alkalmazások hozzá tudnak férni a

Változó (Variable) típusú Plant Simulation objektumokhoz. Például MS Excelből:

"='eM-Plant'|data!'.Models.Frame.Variable'"

A megcímzett alkalmazásnak és a megfelelő fájlnak meg kell nyitva lenni.

A DDE interfész nem igényel külön licencet.
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A Plant Simulation, mint DDE - kliens

Lépések:

1. Először létre kell hozni a kapcsolatot egy alkalmazáshoz – ez egy csatornát nyit

meg. Visszaadja a csatorna számát, például egy globális változóval, itt most

ennek a neve Channel. A csatornaszám mindig nagyobb, mint nulla.

• Channel := ddeConnect("Excel", "Table1");

2. Ez után át kell küldeni az adatot a ddePoke metódussal - paraméterei a

megnyitott csatorna száma, a mező neve, és a küldendő adat, valamint egy

időtúllépés érték milliszekundumokban:

• ddePoke(Channel,<field>,to_str(Drain.numIn),1000);

3. A szimuláció vagy az adatküldés befejeztével be kell zárni a megnyitott

csatornát:

ddeDisconnect(Channel);

Channel := 0;
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Példa: Statisztikai értékek írása MS Excelbe 
DDE-n keresztül

is

field1, field2 : string;

do

tab.create;

field1 := "R" + num_to_str(row_counter) + "C1";

field2 := "R" + num_to_str(row_counter) + "C1";

ddePoke(channel, field1, to_str (@.ID), 1000);

ddePoke(channel, field1, to_str (@.statAvrgLifeSpan), 1000);

row_counter := row_counter+1;

end;

-- field: a következő MS Excel sor megcímzése "R1C1" Row1Column1.

-- row_counter: globális változó.

Az MS Excel táblázatnak nyitva kell lennie!
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ODBC: Külön licencet igénylő kiegészítés tetszőleges ODBC adatbázishoz történő

hozzáférésre, pl: MS Excel, dBase, szövegfájlok, Oracle, Informix, stb.

SQL/Oracle: Külön licencet igénylő kiegészítés. Lehetőséget nyújt Oracle 8.0/8.1

adatbázisokhoz történő hozzáférésre az SQL*Net interfészen keresztül.

Socket: Külön licencet igénylő kiegészítés. Két folyamat TCP/IP protokoll alapú

kommunikációját biztosítja kétirányú adatcserével.

További adatbázis interfészek
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A File Interface (fájl interfész) objektum

A FileInterface más programok által nyújtott

adatok kezelésére biztosít egyszerű felületet.

Használható Plant Simulation statisztikai, szimulációs adatok mentésére külső

fájlba, illetve szövegfájlok Plant Simulationbe történő beolvasására. Nem

szükséges a használata előtt táblázatba írni az adatokat.

• Ikon:

• Kapacitás: 0

• Aktív információáram objektum

Jellemzők:
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A File Interface (fájl interfész) objektum

Adja meg a nevet, amely az objektumra

jellemző (Name).

Adja meg a fájlnevet (File name), melyet

létre kíván hozni.

Vagy a File name gombra kattintva

válasszon ki egy mappát és egy fájlt.

Új adat érkezésekor a FileInterface az új adatot a meglévő adat végére írja.

A fájl tartalmának törlése a Delete File gombbal vagy a következő metódussal

lehetséges:

<name_of_FileInterface>.remove;
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File Interface (fájl interfész) metódusai

<name_of_FileInterface>.writeLn(<data>," ; ","string");

Ez a metódus egy sort ír ki a fájlba. Az oszlopok között elválasztót kell

használni. Így könnyebbé válik az adat feldolgozása más alkalmazásokban.

< name_of_FileInterface>.readLn;

Ez a metódus egy sort olvas a fájlból, és megnöveli a belső fájl kurzort eggyel.

< name_of_FileInterface>.eof;

Ez a metódus a kurzorral a fájl végéhez ugrik.
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File Interface (fájl interfész) metódusai

Példa:

while not FileInterface.eof loop str := FileInterface.readLn...

 Ez után az érték táblázatba írható, vagy helyi változóként használható.

FileInterface.remove;

 Törli a FileInterface által használt fájlt.
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Fájlok beágyazása

Egy fájlt a beágyazáshoz a Windows Intézőből húzd és ejtsd módszerrel rá kell dobni a

Frame - re, amelybe be kívánjuk ágyazni.
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Függelék

Példák
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MU kimenet rögzítése a gyár egy szakaszán

Az EventController.absSimTime az EventController aktuális idejével tér

vissza. Az MU - n belül egy egyedi jellemző definiálható, ami ezt az időértéket használja.

Példa: MU kimenet rögzítése a gyár egy szakaszán
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EventController irányítása metódussal

Példa: Az MU-k érkezési ideje, mint az alkatrészek szállítási ideje.

• Adja meg a végidőt (End) a szimulációra az EventController - ben.

• Írja az MU - k érkezési idejét egy táblába. Mentse el a táblát

szövegfájlként a következő metódussal:

.writeFile("D:\\...").

• Várja meg, amíg a szimuláció befejeződik. Indítsa az EventController

- t a modellben az Endsim metódussal:

<Path>.EventController.reset; 

<Path>.EventController.init; 

<Path>.EventController.start;

• A meghívott modell Init metódusa a szövegfájlt olvassa be:

<tablefile>.readFile("D:\\...D).
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Köszönöm a figyelmet!


